Quit running around in circles!
Let FrameMaker 11 do the heavy lifting.

For more than 20 years, FrameMaker has been the choice for technical communicators worldwide.

Like any sophisticated machine, FrameMaker works best when set up and maintained properly. Use the information and techniques in this book to get the most out of your FrameMaker investment.

Quickly learn to:
- perform basic operations and word processing functions
- design templates and maintain them
- manage workflows and workgroups
- get started with Adobe ExtendScript
- create custom master pages and reference pages
- work with books, tables of contents, and indexes
- use conditional text and other forms of content reuse

Join the conversation, visit www.framemaker11book.com. There you’ll find blog posts, comments and the most up-to-date information about FrameMaker.

“Content is a business asset worthy of being managed. In Publishing Fundamentals: Unstructured FrameMaker 11, Matt and Sarah clearly show you how to efficiently and effectively use FrameMaker to get the most out of your content strategy.”

- Scott Abel, The Content Wrangler
What industry experts are saying about
Publishing Fundamentals: Unstructured FrameMaker 11:

The first complete third-party learning resource for unstructured FrameMaker to be published in more than 5 years.

This is a long-overdue resource for one of the world’s most popular technical authoring and publishing tools and a welcome addition to the technical communicators’ canon.

Alan Houser
President, Society for Technical Communication, 2012–2013

Content is a business asset worthy of being managed.
In *Publishing Fundamentals: Unstructured FrameMaker 11*, Matt and Sarah clearly show you how to efficiently and effectively use FrameMaker to get the most out of your content strategy.

Scott Abel
The Content Wrangler

*Publishing Fundamentals: Unstructured FrameMaker 11* is a great reference for anyone interested in learning about FrameMaker, or for those who just want to get caught up on all the changes that have occurred over the years.

Al Martine
Director, TechWhirl.Com

(With apologies to Paul Simon) “Like a bridge over troubled water, I will ease your mind...” If you’ve tried to fight your way through the FrameMaker help to understand the intricacies of using FrameMaker, then this book will certainly dry your tears and comfort you as it presents a deep, clear and concise understanding of the inner workings of unstructured FrameMaker 11.

Arnis Gubins,
Adobe Community Professional and Community Moderator - FrameMaker
PUBLISHING FUNDAMENTALS:
UNSTRUCTURED FRAMEMAKER 11
About the Authors

In the past 20 years, Matt Sullivan has managed electronic prepress departments, and has owned and operated an Adobe Authorized training facility. Matt has provided FrameMaker- and RoboHelp-related services to companies since 1991. He currently holds 10 Adobe Certified Instructor (both ACI and ACE) credentials including certifications for all products in the TCS4 Suite. He is also certified in Adobe eLearning and in Adobe Creative Suite applications used in graphic design and commercial printing. Matt provides contract training and workflow analysis to companies for technical communication and eLearning departments. When not on a computer, Matt enjoys beach and mountain sports and helping his wife Marianne raise their two lovely daughters.

Sarah O’Keefe is the founder of Scriptorium Publishing (www.scriptorium.com) and a content strategy consultant. Sarah’s focus is how to use technical content to solve business problems; she is especially interested in how new technologies can streamline publishing workflows to achieve strategic goals. Her latest book is Content Strategy 101: Transform Technical Content into a Business Asset.

Rick Quatro is president of Carmen Publishing Inc. and has been working with FrameMaker since 1993. He has written over 6,600 scripts since 1997 for clients worldwide. He is recognized as one of the top FrameMaker automation experts in the world.
# Table of Contents

Acknowledgments ......................................................... xxi
Preface ........................................................................... xxxi
Introduction ................................................................... xxv
What’s New Since FrameMaker 8 ................................. xxvi
  FrameMaker 9 New Features ........................................ xxvi
  FrameMaker 10 New Features ........................................ xxvi
  FrameMaker 11 New Features ........................................ xxvi
Who Should Read This Book ........................................ xxvii
What’s in This Book ........................................................... xxvii

**Part I, Getting Started with FrameMaker** ............................................ xxvii

1 Why FrameMaker? ................................................................. 3
  FrameMaker 11 Strengths ................................................ 4
  Uses for FrameMaker ....................................................... 7

2 Creating Your First Document .................................................. 9
  Starting FrameMaker ....................................................... 9
  Setting Up a New Document .............................................. 10
    Exploring the Standard Templates ....................... 11
    Using a File as a Template .................................... 12
    Creating a Blank Document .................................... 13
    Using an Existing File ........................................... 14
  Opening, Saving, Closing, and Printing Documents ......... 15
  Understanding the Document Window ....................... 15
    Changing the Zoom Settings ................................ 16
    Displaying Nonprinting Items in the Document Window . 17
    Changing View Options ....................................... 19
  FrameMaker Interface Options .................................. 20
    Workspaces ....................................................... 20
    Toolbars .......................................................... 20
    Document Tabs ................................................... 21
    Panels ............................................................. 21

**Part II, Creating and Manipulating Text** ........................................ xxviii

**Part III, Controlling Page Layout** ........................................... xxix

**Part IV, Building Books** ....................................................... xxix

**Part V, Creating Output** ...................................................... xxx

**Part VI, Advanced Techniques** ............................................. xxx

**Part VII, Appendixes** ............................................................ xxxi

Conventions Used in This Book ........................................... xxxii
Mistakes Were Made… .......................................................... xxxii
Table of Contents

Understanding File Configuration and Preferences .................................. 22
Handling Missing Fonts ............................................................................. 24
Using the Fonts Panel ................................................................................ 25
Organizing Directories and Files .............................................................. 26
Saving File Information with XMP ............................................................ 27
Setting Automatic Backup and Save Features ......................................... 28
Switching Between Structured and Unstructured Interfaces ..................... 29
File Naming Conventions ......................................................................... 29

Part II, Creating and Manipulating Text

3 Word-Processing Features ................................................................. 33
Standard Word-Processing Features ...................................................... 33
Undoing and Redoing Changes ............................................................... 33
Inserting Special Characters ................................................................ 35
Searching and Replacing ........................................................................ 38
Spell-Checking ....................................................................................... 43
Thesaurus ............................................................................................... 50
Configuring Default Text Options ......................................................... 52
Smart Quotes ......................................................................................... 52
Smart Spaces ........................................................................................ 53
Restricting Line Breaks .......................................................................... 54
Formatting Superscripts, Subscripts, and Small Caps ............................ 54
Tracking Changes .................................................................................. 55
Using the Track Text Edits Tool ............................................................. 56
Displaying the Word Count ..................................................................... 58
Using Change Bars ................................................................................ 59
Displaying Line Numbers ....................................................................... 61
Comparing Documents and Books ......................................................... 61
Working with Footnotes ......................................................................... 64
Inserting Footnotes ................................................................................ 65
Using the Same Number for Several Footnotes .................................... 65
Customizing Footnote Properties ............................................................ 67
Importing Text from Other Applications ................................................. 70

4 Establishing a Workflow in FrameMaker .............................................. 73
Planning ................................................................................................ 74
Creating and Editing Content ................................................................ 75
Illustration ............................................................................................. 76
Editing/Reviewing .................................................................................. 76
Production Editing .................................................................................. 77
Indexing ................................................................................................ 77
Printing .................................................................................................. 78
Multichannel Publishing ........................................................................ 78
Evaluating Workflow Options ............................................................... 79
Single-Sourcing Workflows .................................................................... 83
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language Support</td>
<td>86</td>
</tr>
<tr>
<td>Unicode Support</td>
<td>86</td>
</tr>
<tr>
<td>Dictionary Support</td>
<td>87</td>
</tr>
<tr>
<td>5 Templates</td>
<td>89</td>
</tr>
<tr>
<td>Why You Should Care About Templates</td>
<td>90</td>
</tr>
<tr>
<td>Getting Started with Templates</td>
<td>90</td>
</tr>
<tr>
<td>Importing Settings from a Template File</td>
<td>91</td>
</tr>
<tr>
<td>What's Imported?</td>
<td>92</td>
</tr>
<tr>
<td>What Makes a “Good” Template?</td>
<td>93</td>
</tr>
<tr>
<td>Understanding Template Interactions</td>
<td>93</td>
</tr>
<tr>
<td>Color Definitions</td>
<td>94</td>
</tr>
<tr>
<td>Character Tags</td>
<td>94</td>
</tr>
<tr>
<td>Graphic Objects</td>
<td>94</td>
</tr>
<tr>
<td>Conditional Text Tags</td>
<td>95</td>
</tr>
<tr>
<td>Paragraph Tags</td>
<td>95</td>
</tr>
<tr>
<td>Table Tags</td>
<td>95</td>
</tr>
<tr>
<td>Cross-Reference Formats</td>
<td>96</td>
</tr>
<tr>
<td>Variable Definitions</td>
<td>96</td>
</tr>
<tr>
<td>Reference Pages</td>
<td>97</td>
</tr>
<tr>
<td>Markers</td>
<td>97</td>
</tr>
<tr>
<td>Math Definitions</td>
<td>97</td>
</tr>
<tr>
<td>Master Pages</td>
<td>98</td>
</tr>
<tr>
<td>PDF Settings</td>
<td>98</td>
</tr>
<tr>
<td>Tips and Tricks</td>
<td>99</td>
</tr>
<tr>
<td>Paragraph Tags</td>
<td>99</td>
</tr>
<tr>
<td>Character Tags</td>
<td>101</td>
</tr>
<tr>
<td>Table Tags</td>
<td>101</td>
</tr>
<tr>
<td>Reference Pages</td>
<td>102</td>
</tr>
<tr>
<td>Entering Special Characters in Dialog Boxes</td>
<td>102</td>
</tr>
<tr>
<td>Naming Conventions</td>
<td>106</td>
</tr>
<tr>
<td>Capitalization</td>
<td>106</td>
</tr>
<tr>
<td>Special Characters</td>
<td>106</td>
</tr>
<tr>
<td>Taking Keyboard Shortcuts into Account</td>
<td>107</td>
</tr>
<tr>
<td>Format vs. Function Names</td>
<td>107</td>
</tr>
<tr>
<td>Separating Out “Housekeeping” Tags</td>
<td>108</td>
</tr>
<tr>
<td>Documenting Your Template</td>
<td>109</td>
</tr>
<tr>
<td>Using Single-Purpose Templates</td>
<td>110</td>
</tr>
<tr>
<td>6 Formatting Text with Paragraph Tags</td>
<td>111</td>
</tr>
<tr>
<td>Applying Paragraph Tags</td>
<td>111</td>
</tr>
<tr>
<td>Using the Paragraph Catalog to Apply a Tag</td>
<td>111</td>
</tr>
<tr>
<td>Using the Formatting Bar</td>
<td>113</td>
</tr>
<tr>
<td>Selecting a Menu Choice</td>
<td>113</td>
</tr>
<tr>
<td>Using the Right-Click Pop-Up Menu</td>
<td>113</td>
</tr>
<tr>
<td>Using Keyboard Shortcuts</td>
<td>114</td>
</tr>
</tbody>
</table>
## Table of Contents

### Avoiding Formatting Overrides
- 114

### Modifying Paragraph Tags
- 115
  - Paragraph Designer Settings
    - 115
- 129
  - Renaming Paragraph Tags
    - 130
  - Setting Properties Across the Entire Paragraph Catalog
    - 131
  - Updating Selected Paragraphs Globally
    - 132
- 132
  - Deleting Paragraph Tags
    - 134
  - Autonumbering Details
    - 135
    - Basic Autonumbering
      - 135
    - Numbered Steps (1, 2, 3 and a, b, c)
      - 136
    - Incorporating Chapter and Volume Numbers
      - 139
    - Creating Numbered Headings
      - 141
    - Marking the End of a Story
      - 142

### 7 Formatting Text with Character Tags
- 143
  - Applying Character Tags
    - 143
    - Using the Character Catalog to Apply a Tag
      - 144
    - Selecting a Menu Choice
      - 144
    - Using the Right-Click Pop-Up Menu
      - 144
    - Using Keyboard Shortcuts
      - 144
  - Modifying Character Tags
    - 145
    - As Is Character Properties
      - 146
    - Avoiding Character Tag Overrides
      - 146
  - Creating Character Tags
    - 147
    - Renaming Character Tags
      - 148
    - Updating Character Properties Globally
      - 149
  - Removing Character Tag Formatting
    - 151
  - Deleting Character Tags
    - 151
  - Additional Character Tags Tips
    - 152

### 8 Understanding Table Design
- 155
  - Inserting Tables
    - 155
    - Selecting Cells
      - 157
    - Moving and Deleting Tables
      - 157
  - Changing the Assigned Table Tag
    - 158
  - Modifying a Table Tag
    - 159
    - Changing Table Designer Settings
      - 160
    - Globally Updating Table Tags
      - 163
  - Creating a Table Tag
    - 164
  - Customizing Tables Outside the Table Designer
    - 164
    - Adding and Deleting Rows and Columns
      - 164
    - Resizing Columns
      - 166
    - Applying Paragraph Tags
      - 168
  - Customizing Cell Ruling and Shading
    - 169
  - Merging Table Cells
    - 172
# Table of Contents

- Rotating Table Cells .................................................. 174
- Sorting Table Data ..................................................... 175
- Deleting Table Tags ..................................................... 177
- Creating Tables from Text ............................................. 178
- Converting a Table to Text ............................................ 181

## 9 Cross-References ..................................................... 183
- Inserting Cross-References ........................................... 185
  - Creating Paragraph-Based Cross-References ..................... 185
  - Creating Spot Cross-References .................................. 186
- Setting Up Cross-Reference Formats ................................ 187
- Formatting Cross-References ........................................ 188
  - Cross-Reference Building Blocks .................................. 189
  - Cross-Reference Examples .......................................... 192
- Deleting Cross-Reference Formats ................................ 192
- Updating Cross-References .......................................... 193
  - Automatic Updating Problems ..................................... 193
  - Updating Cross-References in a Book ............................ 193
  - Forcing a Cross-Reference Update ................................ 194
  - Preventing Automatic Updates .................................... 194
  - Renaming Files Without Breaking Cross-References .......... 195
- Correcting Broken (Unresolved) Cross-References ............... 195
  - Changing the Referenced File .................................... 196
  - Replacing Broken Cross-References ............................... 197
- Converting Cross-References to Text ............................... 197

## 10 Storing Content in Variables .................................... 199
- Inserting Variables .................................................... 200
  - Using the Panel ...................................................... 201
  - Using the Right-Click Pop-Up Menu ............................... 201
  - Using a Keyboard Shortcut ........................................ 201
- Modifying System Variable Definitions ............................. 201
  - Date and Time Variables .......................................... 203
  - Numerical Variables .............................................. 205
  - Filename Variables ................................................ 206
  - Table Variables .................................................... 206
  - Running Header/Footer Variables ................................ 207
- Updating System Variables .......................................... 211
- Creating User Variables .............................................. 212
  - Modifying User Variable Definitions ............................. 214
  - Converting User Variables to Text ............................... 214
- Deleting User Variables .............................................. 215
# Part III, Controlling Page Layout

## 11 Understanding Master Pages

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying Master Pages</td>
<td>219</td>
</tr>
<tr>
<td>Assigning Master Pages to Body Pages</td>
<td>220</td>
</tr>
<tr>
<td>Creating and Managing Master Pages</td>
<td>221</td>
</tr>
<tr>
<td>- Creating Default Master Pages</td>
<td>221</td>
</tr>
<tr>
<td>- Creating Custom Master Pages</td>
<td>221</td>
</tr>
<tr>
<td>- Renaming Master Pages</td>
<td>223</td>
</tr>
<tr>
<td>- Rearranging Master Pages</td>
<td>223</td>
</tr>
<tr>
<td>Modifying Master Pages</td>
<td>224</td>
</tr>
<tr>
<td>- Adding Text Flows</td>
<td>224</td>
</tr>
<tr>
<td>- Setting Up Headers and Footers</td>
<td>224</td>
</tr>
<tr>
<td>- Setting Up a Watermark Effect</td>
<td>225</td>
</tr>
<tr>
<td>- Creating a Landscape Master Page</td>
<td>228</td>
</tr>
<tr>
<td>- Creating Bleeding Tabs</td>
<td>232</td>
</tr>
<tr>
<td>Removing Master Page Overrides</td>
<td>237</td>
</tr>
<tr>
<td>- Mapping Paragraph Tags to Master Pages</td>
<td>237</td>
</tr>
<tr>
<td>- Updating Master Pages and Page Layouts</td>
<td>241</td>
</tr>
<tr>
<td>Deleting Master Pages</td>
<td>243</td>
</tr>
</tbody>
</table>

## 12 Text Flows

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Text Flows</td>
<td>245</td>
</tr>
<tr>
<td>Text Frame Overflows</td>
<td>246</td>
</tr>
<tr>
<td>Understanding Text Frame Properties</td>
<td>247</td>
</tr>
<tr>
<td>Adding Text Flows</td>
<td>248</td>
</tr>
<tr>
<td>Drawing Text Frames on the Body Page</td>
<td>249</td>
</tr>
<tr>
<td>Selecting Text Frames</td>
<td>250</td>
</tr>
<tr>
<td>Resizing Text Frames</td>
<td>251</td>
</tr>
<tr>
<td>Moving and Copying Text Frames</td>
<td>252</td>
</tr>
<tr>
<td>Deleting Text Frames</td>
<td>252</td>
</tr>
<tr>
<td>Customizing Text Flows</td>
<td>253</td>
</tr>
<tr>
<td>Connecting Text Flows</td>
<td>253</td>
</tr>
<tr>
<td>Creating Room for Side Heads</td>
<td>255</td>
</tr>
<tr>
<td>Adding Columns</td>
<td>259</td>
</tr>
<tr>
<td>Aligning Text Across Columns</td>
<td>260</td>
</tr>
<tr>
<td>Splitting Text Frames</td>
<td>264</td>
</tr>
<tr>
<td>Disconnecting Text Frames</td>
<td>265</td>
</tr>
<tr>
<td>Changing the Flow Tag</td>
<td>266</td>
</tr>
<tr>
<td>Switching from Single- to Double-Sided Pages</td>
<td>267</td>
</tr>
<tr>
<td>Chapter</td>
<td>Section</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
</tr>
<tr>
<td>13</td>
<td>Importing Graphic Content</td>
</tr>
<tr>
<td></td>
<td>Anchoring Graphics</td>
</tr>
<tr>
<td></td>
<td>Inserting an Anchored Frame</td>
</tr>
<tr>
<td></td>
<td>Positioning Anchored Frames</td>
</tr>
<tr>
<td></td>
<td>Importing a Graphic</td>
</tr>
<tr>
<td></td>
<td>Shrink-Wrapping an Anchored Frame</td>
</tr>
<tr>
<td></td>
<td>Relinking Missing Imported Graphics</td>
</tr>
<tr>
<td></td>
<td>Setting Anchored Frame Object Properties</td>
</tr>
<tr>
<td></td>
<td>Graphic Formats</td>
</tr>
<tr>
<td></td>
<td>Choosing the Best Graphics Format</td>
</tr>
<tr>
<td></td>
<td>Image Facets</td>
</tr>
<tr>
<td></td>
<td>Cross-Platform Images</td>
</tr>
<tr>
<td></td>
<td>Transparency</td>
</tr>
<tr>
<td></td>
<td>Placing Graphics on the Reference Pages</td>
</tr>
<tr>
<td></td>
<td>Placing Graphics Above and Below the Paragraph</td>
</tr>
<tr>
<td></td>
<td>Placing Graphics “Beside” a Paragraph</td>
</tr>
<tr>
<td></td>
<td>Changing the Name of a Graphic Frame</td>
</tr>
<tr>
<td></td>
<td>Importing Graphics on a Master Page</td>
</tr>
<tr>
<td>14</td>
<td>Object Styles</td>
</tr>
<tr>
<td></td>
<td>Create an Object Style</td>
</tr>
<tr>
<td></td>
<td>Create an Object Style from an Object</td>
</tr>
<tr>
<td></td>
<td>Create an Object Style from Scratch</td>
</tr>
<tr>
<td></td>
<td>Display the Object Style Panel with a Shortcut</td>
</tr>
<tr>
<td></td>
<td>Using Object Styles in a Regular Workflow</td>
</tr>
<tr>
<td>15</td>
<td>Placing Rich Media</td>
</tr>
<tr>
<td></td>
<td>Supported Formats</td>
</tr>
<tr>
<td></td>
<td>Placing a Multimedia File</td>
</tr>
<tr>
<td></td>
<td>Full-Motion Video</td>
</tr>
<tr>
<td></td>
<td>Set Movie Poster</td>
</tr>
<tr>
<td></td>
<td>Set Graphic Name</td>
</tr>
<tr>
<td></td>
<td>Create Video Player Controls</td>
</tr>
<tr>
<td></td>
<td>Create Cue Points</td>
</tr>
<tr>
<td></td>
<td>Activate SWF and FLV By Default</td>
</tr>
<tr>
<td></td>
<td>Interactive Simulations</td>
</tr>
<tr>
<td></td>
<td>3D Objects</td>
</tr>
<tr>
<td></td>
<td>Inserting a Multimedia Links Table</td>
</tr>
<tr>
<td></td>
<td>Link 3D Part to Text</td>
</tr>
<tr>
<td></td>
<td>Activate 3D By Default</td>
</tr>
<tr>
<td></td>
<td>Display 3D and Multimedia in Pop-Up Windows</td>
</tr>
<tr>
<td></td>
<td>Other 3D Control Options</td>
</tr>
<tr>
<td></td>
<td>3D Object Support for JavaScript</td>
</tr>
</tbody>
</table>
16  **FrameMaker's Graphics Tools** ........................................ 309
    Drawing Basic Shapes ............................................. 310
    Working with Grids ................................................. 313
    Selecting Objects .................................................. 314
    Deleting Objects .................................................... 315
    Modifying Objects ................................................... 315
    Resizing .............................................................. 319
    Reshaping ............................................................ 321
    Smoothing Corners .................................................. 322
    Changing the Number of Sides ..................................... 323
    Joining Lines ........................................................ 324
    Cropping and Masking Graphics .................................... 326
    Rearranging Objects ................................................. 327
    Aligning .............................................................. 327
    Distributing ........................................................ 329
    Grouping ............................................................. 330
    Running Text Around an Object .................................... 331
    Layering Objects .................................................... 332
    Changing the Orientation .......................................... 333
    Rotating .............................................................. 333
    Flipping Horizontally or Vertically ............................... 334
    Transparency in FrameMaker Graphics ............................ 335
    Image Hotspots ...................................................... 335

**Part IV, Building Books**

17  **Setting Up Book Files** ........................................... 339
    Creating a Book File ................................................. 339
    What the Book Window Tells You ................................... 340
    Managing Files in the Book ........................................ 340
    Adding Files .......................................................... 341
    Adding Special Book Structures .................................... 343
    Opening, Closing, and Saving All Files .......................... 346
    Removing Files ....................................................... 346
    Rearranging Files ................................................... 346
    Renaming Files ....................................................... 347
    Updating the Book .................................................... 348
    Troubleshooting Book Updates ...................................... 349
    Managing Numbering ................................................ 352
    Printing a Book ...................................................... 362
    Modifying Files from the Book ..................................... 362
    Spell-Checking and Finding/Changing Items ....................... 362
    Book-Level Features ................................................ 363
    Choosing Files When Performing Other Book-Level Operations 363
    Book Features Available Inside Files ............................ 364
    Paging Through Files in a Book .................................... 364
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>18</td>
<td>Creating Tables of Contents</td>
<td>365</td>
</tr>
<tr>
<td></td>
<td>Setting Up the Table of Contents File</td>
<td>365</td>
</tr>
<tr>
<td></td>
<td>The Initial Table of Contents File</td>
<td>368</td>
</tr>
<tr>
<td></td>
<td>Customizing the Table of Contents</td>
<td>368</td>
</tr>
<tr>
<td></td>
<td>Locating the TOC Reference Flow</td>
<td>369</td>
</tr>
<tr>
<td></td>
<td>Understanding the TOC Flow Entries</td>
<td>371</td>
</tr>
<tr>
<td></td>
<td>Formatting the Table of Contents</td>
<td>373</td>
</tr>
<tr>
<td></td>
<td>Using Character-Level Formatting</td>
<td>373</td>
</tr>
<tr>
<td></td>
<td>Formatting Examples</td>
<td>373</td>
</tr>
<tr>
<td>19</td>
<td>Creating Indexes</td>
<td>379</td>
</tr>
<tr>
<td></td>
<td>Creating the Index File</td>
<td>380</td>
</tr>
<tr>
<td></td>
<td>Creating Index Entries</td>
<td>380</td>
</tr>
<tr>
<td></td>
<td>Basic Entries</td>
<td>382</td>
</tr>
<tr>
<td></td>
<td>Editing and Deleting Index Entries</td>
<td>384</td>
</tr>
<tr>
<td></td>
<td>Creating Subentries</td>
<td>384</td>
</tr>
<tr>
<td></td>
<td>Stacking Multiple Entries in a Single Index Marker</td>
<td>384</td>
</tr>
<tr>
<td></td>
<td>Creating Ranges</td>
<td>385</td>
</tr>
<tr>
<td></td>
<td>Creating References to Synonyms (“See”)</td>
<td>386</td>
</tr>
<tr>
<td></td>
<td>Changing Sorting Order for a Single Entry</td>
<td>387</td>
</tr>
<tr>
<td></td>
<td>Formatting the Index</td>
<td>387</td>
</tr>
<tr>
<td></td>
<td>Ignoring Characters While Sorting</td>
<td>389</td>
</tr>
<tr>
<td></td>
<td>Modifying Page Separators</td>
<td>389</td>
</tr>
<tr>
<td></td>
<td>Changing the Sort Order</td>
<td>390</td>
</tr>
<tr>
<td></td>
<td>Changing the Group Titles</td>
<td>391</td>
</tr>
<tr>
<td></td>
<td>Formatting the Page Number</td>
<td>391</td>
</tr>
<tr>
<td></td>
<td>Creating Ranges Automatically</td>
<td>392</td>
</tr>
<tr>
<td></td>
<td>Eliminating Unwanted Chapter Numbers</td>
<td>393</td>
</tr>
<tr>
<td>20</td>
<td>Creating Other Generated Files</td>
<td>395</td>
</tr>
<tr>
<td></td>
<td>Creating Paragraph-Based Lists</td>
<td>397</td>
</tr>
<tr>
<td></td>
<td>List of Figures</td>
<td>397</td>
</tr>
<tr>
<td></td>
<td>List of Tables</td>
<td>398</td>
</tr>
<tr>
<td></td>
<td>List of Paragraphs</td>
<td>398</td>
</tr>
<tr>
<td></td>
<td>Alphabetical List of Paragraphs</td>
<td>398</td>
</tr>
<tr>
<td></td>
<td>Creating Lists of Other Items</td>
<td>398</td>
</tr>
<tr>
<td></td>
<td>List of Markers</td>
<td>399</td>
</tr>
<tr>
<td></td>
<td>Alphabetical List of Markers</td>
<td>399</td>
</tr>
<tr>
<td></td>
<td>List of References</td>
<td>399</td>
</tr>
<tr>
<td></td>
<td>Generated Indexes</td>
<td>402</td>
</tr>
<tr>
<td></td>
<td>Index of Authors</td>
<td>402</td>
</tr>
<tr>
<td></td>
<td>Index of Subjects</td>
<td>403</td>
</tr>
<tr>
<td></td>
<td>Index of Markers</td>
<td>403</td>
</tr>
<tr>
<td></td>
<td>Index of References</td>
<td>403</td>
</tr>
</tbody>
</table>
**Table of Contents**

**Part V, Creating Output**

<table>
<thead>
<tr>
<th>21</th>
<th>Print and PDF Output</th>
<th>407</th>
</tr>
</thead>
<tbody>
<tr>
<td>21.1</td>
<td>Printing Your Documents</td>
<td>408</td>
</tr>
<tr>
<td>21.2</td>
<td>Printing an Individual Document</td>
<td>409</td>
</tr>
<tr>
<td>21.3</td>
<td>Printing from the Book File</td>
<td>409</td>
</tr>
<tr>
<td>21.4</td>
<td>Specifying Pages</td>
<td>409</td>
</tr>
<tr>
<td>21.5</td>
<td>Printing Several Copies</td>
<td>411</td>
</tr>
<tr>
<td>21.6</td>
<td>Changing the Paper Size</td>
<td>411</td>
</tr>
<tr>
<td>21.7</td>
<td>Printing Double-Sided Documents</td>
<td>411</td>
</tr>
<tr>
<td>21.8</td>
<td>Skipping Blank Pages</td>
<td>412</td>
</tr>
<tr>
<td>21.9</td>
<td>Printing Thumbnails</td>
<td>412</td>
</tr>
<tr>
<td>21.10</td>
<td>Printing Spot Color in Black and White</td>
<td>413</td>
</tr>
<tr>
<td>21.11</td>
<td>Printing Low-Resolution Images</td>
<td>413</td>
</tr>
<tr>
<td>21.12</td>
<td>Printing Registration Marks</td>
<td>414</td>
</tr>
<tr>
<td>21.13</td>
<td>Changing the Printer</td>
<td>415</td>
</tr>
<tr>
<td>21.14</td>
<td>About Color Separations</td>
<td>415</td>
</tr>
<tr>
<td>21.15</td>
<td>Adobe PDF Creation Add-On</td>
<td>416</td>
</tr>
<tr>
<td>21.16</td>
<td>Setting PDF Job Options</td>
<td>416</td>
</tr>
<tr>
<td>21.17</td>
<td>Creating PDF Files</td>
<td>419</td>
</tr>
<tr>
<td>21.18</td>
<td>Generating Bookmarks</td>
<td>420</td>
</tr>
<tr>
<td>21.19</td>
<td>Threading Articles</td>
<td>422</td>
</tr>
<tr>
<td>21.20</td>
<td>Specifying the Default Zoom Level and First Displayed Page</td>
<td>423</td>
</tr>
<tr>
<td>21.21</td>
<td>Setting Up Registration Marks in a PDF File</td>
<td>424</td>
</tr>
<tr>
<td>21.22</td>
<td>Generating Tagged PDF Files</td>
<td>424</td>
</tr>
<tr>
<td>21.23</td>
<td>Optimizing PDF Files</td>
<td>425</td>
</tr>
<tr>
<td>21.24</td>
<td>Creating Hyperlinks to Other PDF Files</td>
<td>427</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>22</th>
<th>Producing Online Output</th>
<th>429</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.1</td>
<td>Saving as HTML</td>
<td>430</td>
</tr>
<tr>
<td>22.2</td>
<td>Saving a Single Document File as HTML</td>
<td>430</td>
</tr>
<tr>
<td>22.3</td>
<td>Saving a Book as HTML</td>
<td>431</td>
</tr>
<tr>
<td>22.4</td>
<td>Customizing HTML Output</td>
<td>431</td>
</tr>
<tr>
<td>22.5</td>
<td>Modifying Conversion Settings Interactively</td>
<td>431</td>
</tr>
<tr>
<td>22.6</td>
<td>Modifying the Reference Pages</td>
<td>436</td>
</tr>
<tr>
<td>22.7</td>
<td>Mapping Character Tags</td>
<td>437</td>
</tr>
<tr>
<td>22.8</td>
<td>Mapping Cross-Reference Formats</td>
<td>438</td>
</tr>
<tr>
<td>22.9</td>
<td>Modifying Style Sheet Information</td>
<td>439</td>
</tr>
<tr>
<td>22.10</td>
<td>Modifying Page Opening and Closing Code</td>
<td>440</td>
</tr>
<tr>
<td>22.11</td>
<td>Going Beyond Basic Customization</td>
<td>442</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>23</th>
<th>Color Output</th>
<th>443</th>
</tr>
</thead>
<tbody>
<tr>
<td>23.1</td>
<td>Understanding Types of Color</td>
<td>445</td>
</tr>
<tr>
<td>23.2</td>
<td>Understanding Process Color</td>
<td>445</td>
</tr>
<tr>
<td>23.3</td>
<td>Understanding Spot Color</td>
<td>447</td>
</tr>
</tbody>
</table>
### Table of Contents

Applying Color to Text and Objects .................................. 447  
Managing Color Definitions ........................................ 448  
  Modifying Existing Colors ........................................... 449  
  Creating Custom Colors ............................................ 451  
  Adding Colors from a Color Library .............................. 452  
  Renaming Colors .................................................. 454  
Viewing Colors ........................................................ 455  
  Selecting a Color View ............................................. 455  
  Setting up Color Views ............................................. 456  
Deleting Colors ...................................................... 456  
Controlling Colors for Output ..................................... 457

### Part VI, Advanced Techniques

#### 24 Setting Up Conditional Text ............................. 461  
  How Conditional Text Works ...................................... 461  
  Notes Regarding Conditional Text ............................. 462  
  Strategies for Using Conditional Text ....................... 462  
  Conditional Text Examples ....................................... 463  
  Applying Condition Tags ......................................... 463  
  Removing a Single Condition Tag ............................... 465  
  Removing All Condition Tags from Text ....................... 466  
  Using Condition Indicators ...................................... 466  
  Planning Conditional Text ....................................... 467  
  Common Condition Tags .......................................... 468  
  Alternatives to Conditional Text ............................... 468  
  Creating Condition Tags ......................................... 469  
  Modifying Condition Tags ....................................... 470  
  Deleting a Condition Tag ....................................... 470  
  Showing and Hiding Conditional Text ......................... 471  
    Showing All Conditional Text ................................ 471  
    Choosing the Method for Showing Conditional Text ........ 472  
    Showing or Hiding Conditional Text as per Condition .... 475  
    Using Conditional Text Expressions ......................... 476  
    Modifying Expressions ....................................... 478  
    Deleting Expressions ......................................... 479  
    Examples of Expressions ..................................... 479

#### 25 Automation with ExtendScript ......................... 485  
  A Brief History of FrameMaker Automation .................. 485  
  Getting Started with Scripting ................................. 485  
  Interacting with FrameMaker ExtendScript .................. 486  
    Using the Script Library Panel ............................. 486
# Table of Contents

- Creating and Editing Scripts .......................................................... 489
  - Creating an Alert Box ................................................................. 490
  - Automating Text Entry ............................................................... 490
  - Objects, Properties, and Methods ............................................... 492
- Finding the Correct Objects, Properties, and Methods .................. 493
- Principles of Successful Script Writing ......................................... 496
  - Start Small .................................................................................... 496
  - Use Functions ............................................................................... 497
  - Working With Selections .............................................................. 498

## 26 Creating Interactive Content with Hypertext .......................... 505
- Setting Up a Basic Hypertext Link .................................................. 507
  - Creating Link Destinations .......................................................... 507
  - Creating a Link to a Destination ................................................... 508
  - Creating the Active Area in Text ................................................. 509
  - Activating Links ........................................................................... 509
- Creating Hotspots ........................................................................... 509
  - Using Hotspot Properties to Create Links .................................... 510
  - Using Hotspot Mode to Create Links ........................................... 510
  - Using a Text Frame as a Hotspot .................................................. 510
- Creating a Text Link to a Web Address ......................................... 511
- Creating an Email Link ................................................................... 511
- Creating Notes in PDF Files .......................................................... 512
- Locking and Unlocking View-Only Documents .............................. 513
- Hypertext Command Reference ...................................................... 513

## 27 Writing Equations ...................................................................... 519
- Understanding the Equations Panel ................................................. 519
- Inserting Equations ......................................................................... 522
  - Using the Equations Palette ......................................................... 523
  - Typing an Equation ....................................................................... 524
  - Selecting Equations and Math Elements ...................................... 524
  - Navigating Through Equations ..................................................... 526
  - Moving Equations ........................................................................ 526
- Modifying Equations ....................................................................... 527
  - Moving Text Using Keyboard Shortcuts ...................................... 527
  - Moving Text Using the Equations Palette .................................... 527
- Deleting Equations .......................................................................... 529
- Formatting Equations ..................................................................... 529
  - Changing Equation Fonts ............................................................. 529
  - Changing Equation Font Sizes ..................................................... 530
  - Inserting Automatic Line Breaks ................................................... 531
  - Changing the Equation Size .......................................................... 531
  - Applying Character Tags ............................................................... 532
- Evaluating Equations ....................................................................... 532
## Table of Contents

### 28 Content Reuse with Text Insets
- A Text Inset Example .................................................. 533
- Working with Text in Insets ........................................... 536
- Considering Text Insets and Other Reuse Options ............... 537
- Planning Modular Text .................................................. 538
  - Breaking Text Down into Modules ............................... 538
  - File Storage .......................................................... 538
  - Information Retrieval ............................................... 539
  - Controlling Formatting in Text Insets ......................... 539
- Creating a Text Inset .................................................. 540
- Managing Text Insets .................................................. 542
  - Opening the Source File ......................................... 544
  - Converting Text Insets to Text ................................. 544

### 29 Using Files with a Content Management System (CMS) ......... 545
- Working with Adobe CQ ............................................... 545
- Creating a Custom Connection to a CMS .......................... 545
- Working with WebDAV ................................................. 546
- Managing Workgroups .................................................. 546
  - Setting up a CMS Connection ..................................... 547
  - Using the Repository Manager .................................... 548
  - Uploading the Current Document ............................... 548

### Part VII, Appendixes

#### Appendix A: Resources ........................................... 551
- FrameMaker and Technical Communication Web Resources .... 551
- Mailing Lists/User Groups ......................................... 551
- Online Output Conversion Tools ................................... 552
- Third-Party Tools and Plug-Ins .................................... 553
- Database Publishing from FrameMaker ............................ 555
- Online Manuals ....................................................... 555
- Reporting Bugs ....................................................... 555

#### Appendix B: Building Blocks ..................................... 557
- Building Block Usage .................................................. 557

#### Appendix C: Customizing maker.ini ................................ 563
- Editing maker.ini ..................................................... 563
- Setting Clipboard Pasting Order .................................... 564
- Updating Graphics from Web Addresses .......................... 564
- Changing the Substitution Fonts .................................... 564
## Table of Contents

**Appendix D: Preference Settings** ................................................. 567
  Global ............................................................................. 567
  General ........................................................................... 567
  Interface .......................................................................... 568
  Alerts .............................................................................. 569
  Panels and Pods ............................................................... 570
  CMS ................................................................................. 571
  Documentum ................................................................. 571
  SharePoint ....................................................................... 571
  Spelling ........................................................................... 572
  Dictionary ....................................................................... 572
  Spelling Options ............................................................ 572

**Appendix E: Maker Interchange Format** ....................................... 573
  Sample MIF Code ............................................................ 573
  Creating a MIF File .......................................................... 577
  Opening a MIF File in FrameMaker ..................................... 578
  Viewing a MIF File ........................................................... 578
  Cool Stuff You Can Do with MIF ........................................ 578
    Eliminating File Corruption Problems .............................. 579
    Making a File Available to an Older Version of FrameMaker .. 579
    Creating a Character Tag for a Vertical Baseline Shift ........ 580
    Using MIF Fragments to Update Catalog Settings .............. 581
    Performing Global Search-and-Replace Operations .......... 582
    Writing Your Own Conversion Tools ................................. 583

**Index** ................................................................................. 585
Acknowledgments

This much-asked-for update to the *Publishing Fundamentals: FrameMaker 8* work would not be possible without the contributions of the entire Scriptorium team, both past and present.

A huge thanks goes out to our team of reviewers and editors. Because of their eagle eyes, and the attention to detail for which Framers are known, this book is easier to read and substantially more accurate.

A huge thanks goes out to our review team, which included:

Jeff Coatsworth, Leah Coughlin, Chris Despopolus, Robert Dougherty, Arnis Gubins, Alan Houser, Al Martine, Scott Prentice, and Rick Quatro. We are grateful that a crew with such impeccable credentials in the Frame community were willing to contribute to this book.

Among our editors, we’d like to specifically thank:

- Leah Coughlin for amazingly accurate proofreading, and all under a deadline.
- Arnis Gubins for detail on printing and many obscure under-the-hood details.
- Rick Quatro for contributing the excellent chapter on ExtendScript.

In addition, we’d like to thank the Adobe FrameMaker development team, including FrameMaker Product Manager Kapil Verma, and TCS4 Product Manager Ankur Jain. Access to them and to their teams has without question made this a better book. Thanks also to the FrameMaker prerelease team; participation in the prerelease program gave us insights to the engineering and feature sets that make up FrameMaker 11.

Matt Sullivan & Sarah O'Keefe
February 2013
Much has changed in FrameMaker since the FrameMaker 8 version of this book, yet much remains the same. Our hope is that this book will give you insight into the workflow that has made FrameMaker the standard in technical book publishing for the last 20 years.

The original text, with content authored and directed by Sarah O’Keefe, has been completely revamped to address the new features, user interface, and workflows available in version 11.

This version also takes into account Matt Sullivan’s perspective as a user of FrameMaker since version 1 on the Mac. Matt has been a FrameMaker implementation specialist and trainer since FrameMaker 5. Along with FrameMaker experience, Matt specializes in multichannel output using components of the Technical Communication Suite. If you use Acrobat, Illustrator, Captivate, or RoboHelp, you will appreciate the perspective his experience brings to this book.

The FrameMaker 8 book “weighed in” at about 750 pages, cover to cover. By reformatting and streamlining the content, we trimmed the volume by over 100 pages, while adding content for versions 9–11.

We will also be selling an EPUB version, available at www.framemaker11book.com. If you have suggestions for the delivery or content of the book, please visit our website.
Welcome to *Publishing Fundamentals: Unstructured FrameMaker 11*. Adobe’s FrameMaker software is the industry leader in technical publishing, and the release of version 11 continues that tradition. FrameMaker specializes in long-document formatting and automates mundane but essential tasks, such as maintaining running headers and footers, and updating tables of contents. It offers an easy path to producing multiple output formats, including print, Portable Document Format (PDF), and mobile formats.

This book shows new users how to use unstructured FrameMaker, which is the traditional FrameMaker user interface, to streamline their publishing workflows and greatly improve efficiency and productivity. For current users, we have provided complete coverage of the new features in version 11 and perhaps some new tips for older features.

One of the most significant changes since the FrameMaker 8 version of this book is the emergence of the mobile web. FrameMaker has kept pace with new technologies like EPUB, Kindle and HTML5. This book will discuss many of the FrameMaker options available for multichannel output.

In addition to writing about FrameMaker, we practice what we preach. We’ve trained, consulted and written about FrameMaker since the early versions. In fact, the book you are holding was itself produced in FrameMaker version 11.

If you would like to express interest in additional FrameMaker or Technical Communication Suite subjects, please visit www.framemaker11book.com.
What’s New Since FrameMaker 8

FrameMaker 9 New Features
- New user interface (UI)
- Added groups and folders to books
- PDF comment workflow
- Content management improvements
- RoboScreenCapture included
- Character Palette including Unicode characters
- History panel

FrameMaker 10 New Features
- Drag-and-drop editing
- Filter by attribute (structured feature)
- Auto spell check
- Find/Change overrides
- Table catalog
- Repeat last operation
- ExtendScript
- Improved placement of multimedia
- Set poster for multimedia
- Set background color
- Suppress alerts
- Improved linking with RoboHelp (Technical Communication Suite version)

FrameMaker 11 New Features
- Interactive multimedia links for 3D objects
- Object styles
- Identify and refer to content using line numbers
- Hotspots
- Smart Insert
- 3D object part links
- Preferences dialog enhancements
- New publishing formats in FrameMaker Publishing Server (requires separate purchase of FrameMaker Publishing Server)
- More markers
- APIs to automate the CMS connectors’ functionality
Who Should Read This Book

The information in this book will be useful for both new and long-time FrameMaker users. The book explains unstructured FrameMaker from top to bottom. It details basics, such as creating a document, importing formats from one file to another, and applying paragraph tags. In more advanced sections, this reference describes how to create templates, build books, use modular text, and insert hypertext commands.

In short, there’s something here for every user. Beginners will find a wealth of information, organized in order of increasing complexity. Advanced users may want to skip the first few parts and focus on the second half of the book.

What’s in This Book

This rather large book is divided into several parts to help you find your way around. You’ll notice that each part has a handy thumb tab to help find the part you need.

Part I, Getting Started with FrameMaker

Part I is intended mainly for new users. It provides an overview of FrameMaker’s features and interface. All users should consider reading Chapter 4, which describes several different workflows that include FrameMaker.

Part I includes the following chapters:

- Chapter 1, Why FrameMaker? offers an overview of FrameMaker’s features. It describes some of the features that make FrameMaker unique and explains how you can use them to automate common publishing tasks. This chapter is intended for users who are new to FrameMaker and need an explanation of why FrameMaker makes sense for technical publishing projects.

- Chapter 2, Creating Your First Document explains how to create a new document and open existing documents. It also describes the document window, toolbars, and status bar. Finally, it explains how to configure preferences to suit your workflow. Read this chapter if you are not familiar with the FrameMaker interface.

- Chapter 3, Word-Processing Features describes how to type text into FrameMaker. It also explains how to import text from other applications. Generally, FrameMaker users write directly in FrameMaker. This chapter will be helpful to new users who are not yet familiar with basic text manipulation in FrameMaker. For more advanced users, the importing section provides detailed information about how to import content from Microsoft Word files successfully.

- Chapter 4, Establishing a Workflow in FrameMaker describes the typical publishing workflow and examines how FrameMaker fits into that workflow. It also includes an overview of how to set up a single-sourcing workflow that lets you publish to multiple output formats. If you are starting with a clean slate and can configure your workflow however you want, read this chapter to get an idea of the possibilities.

- Chapter 5, Templates pulls together information about many different features. It describes interactions among different components and provides some tips for designing useful templates.
Part II, Creating and Manipulating Text

Part II explains the word-processing features of FrameMaker and how to add and manipulate text, tables, and other items in your documents. This part includes basic information, such as how to apply a paragraph tag, but it also covers more advanced topics, such as how to create a paragraph tag and set up autonumbering. New users will want to read at least the first half of each chapter to learn about each feature; more advanced users will probably focus on the latter half of each chapter.

Part II includes the following chapters:

- *Chapter 6, Formatting Text with Paragraph Tags* begins with an explanation of paragraph-level style sheets and how to apply them. It also provides a detailed explanation of how to create and modify paragraph tags.

- *Chapter 7, Formatting Text with Character Tags* shows you how to apply and create character-level style sheets. In FrameMaker, character-level and paragraph-level style sheets are stored in separate locations. Characters tags are used in several other features, such as cross-references and variables, to provide formatting; this chapter also explains those relationships.

- *Chapter 8, Understanding Table Design* explains how to create tables and modify their formatting. Like paragraphs, tables have style sheets, and this chapter describes how to set up table styles.

- *Chapter 9, Cross-References* describes how to create pointers from one section of a document to another. FrameMaker automatically maintains and updates these references as pagination in the document changes.

- *Chapter 10, Storing Content in Variables* details how to use variables to store and format bits of reused text, such as the title of a book or a product name. It also describes how to use system variables to automate running headers and footers, page numbers, and “continued” labels in tables.
Part III, Controlling Page Layout

The chapters in Part III describe managing blocks of text and positioning them on your pages. This part also includes discussions about importing graphics created in other applications and creating graphics in FrameMaker.

Part III includes the following chapters:

- *Chapter 11, Understanding Master Pages* explains how to set up master pages to determine the page layout in a file, and it shows how to apply and import page layout definitions.
- *Chapter 12, Text Flows* describes how to create and connect blocks of text, or text flows. This information is especially helpful for template designers, who need to understand how to position text blocks on a page and how text blocks are connected and disconnected.
- *Chapter 13, Importing Graphic Content* explains anchored frames, which serve as containers for most graphics. It also describes how to import graphics and rich media files from other applications.
- *Chapter 14, Object Styles* introduces object-level style sheets and how to apply them. It also provides a detailed explanation of how to create and modify object styles.
- *Chapter 15, Placing Rich Media* describes the types of multimedia that may be placed within a FrameMaker file. It also explains the controls available for each media type.
- *Chapter 16, FrameMaker’s Graphics Tools* describes how to use FrameMaker’s built-in graphics tools to create art.

Part IV, Building Books

You can create a book file to hold a collection of files that make up a larger document. Among these files, you can include automated tables of contents and index files, which are explained in this part.

Part IV includes the following chapters:

- *Chapter 17, Setting Up Book Files* describes how to set up and modify book files. It explains how to control chapter, page, and other numbering from the book and how to perform global (bookwide) updates on your content.
- *Chapter 18, Creating Tables of Contents* explains how to choose items for inclusion in a table of contents and how to format those items.
- *Chapter 19, Creating Indexes* explains how to create the markers that become index entries and how to format the generated index.
- *Chapter 20, Creating Other Generated Files* describes some of the less well-known generated files. You can, for example, create a list of fonts used in a document, or a list of imported graphics. Several variations on the standard index are also available.
Part V, Creating Output

In Part V, you learn how to create print, PDF, and online formats, and you learn about managing color.

Part V includes the following chapters:

- **Chapter 21, Print and PDF Output** provides detailed information about printing FrameMaker files and creating PDF files. It explains how to configure your system for successful PostScript printing and provides information about PDF conversion settings.

- **Chapter 22, Producing Online Output** describes how to use FrameMaker’s rudimentary built-in HyperText Markup Language (HTML) and Extensible Markup Language (XML) converters, and it also describes the tools and processes for using third-party tools to create robust eBooks, apps, HTML5, HTML and online help from unstructured FrameMaker. (To produce more usable XML and DITA, you should work with structured documents, using the available structured mode in FrameMaker)

- **Chapter 23, Color Output** explains how FrameMaker handles color output and describes how to set up colors in your document.

Part VI, Advanced Techniques

Part VI covers a variety of advanced topics, including template design, conditional text, hypertext, and WebDAV use with FrameMaker.

Part VI includes the following chapters:

- **Chapter 24, Setting Up Conditional Text** explains how to create two (or more) versions of a document in a single file. The conditional text feature is an important part of most single-sourcing environments.

- **Chapter 25, Automation with ExtendScript** provides an overview of FrameMaker automation using Adobe’s ExtendScript technology. Scripting tasks can save countless hours of repetitive manual formatting or processing.

- **Chapter 26, Creating Interactive Content with Hypertext** describes how to link documents, create popups, and insert hotspots into graphics with hypertext commands. Many hypertext commands are translated when you convert to HTML or PDF output.

- **Chapter 27, Writing Equations** tells you how to create and format equations in your documents.

- **Chapter 28, Content Reuse with Text Insets** provides information about FrameMaker’s text importing feature. You can create small text fragments and import them into larger documents to create modular documentation.

- **Chapter 29, Using Files with a Content Management System (CMS)** describes FrameMaker’s support for version control and content management through WebDAV. WebDAV software (www.webdav.org) runs on any web server and is accessed via http protocol, so you can store files anywhere and access them over the Internet. This allows you to set up a version control system for authors in many different locations. The "DAV" in WebDAV actually stands for “Distributed Authoring and Versioning.”
Part VII, Appendixes

The following appendixes are included:

- **Appendix A, Resources** offers a list of FrameMaker-related resources, including a list of utilities.
- **Appendix B, Building Blocks** provides a comprehensive list of the building blocks you use to create tags and formats in FrameMaker.
- **Appendix C, Customizing maker.ini** describes the file where FrameMaker settings are stored and some settings you may want to modify.
- **Appendix D, Preference Settings** provides a reference for preference options. Newly expanded options for content management system integration and spelling checker are now found here.
- **Appendix E, Maker Interchange Format** explains Maker Interchange Format (MIF), which is a text-based markup language that describes FrameMaker files. MIF files can be useful for global changes that aren’t easily implemented through the FrameMaker interface. It’s also widely used as an intermediate format when converting to and from FrameMaker format. FrameMaker files saved in MIF format can be opened in earlier versions of FrameMaker.
Introduction

Conventions Used in This Book

Some of the text in this book uses special formatting to help indicate emphasis or keystrokes. The text conventions are as follows:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sans Serif Small Caps</td>
<td>press the TAB key</td>
<td>Indicates keystrokes. If a keyboard shortcut (such as ESC O P D) contains no hyphens, press each key individually. When keys are joined by hyphens, press the joined keys at the same time; for example, SHIFT-F means to type a capital letter F.</td>
</tr>
<tr>
<td>Sans Serif Italic</td>
<td>single-sourcing</td>
<td>Indicates a defined term, a book title, a placeholder, or text that requires emphasis.</td>
</tr>
<tr>
<td>Sans Serif Bold</td>
<td>if you type 2</td>
<td>Indicates text you type or terms that are being defined in a list.</td>
</tr>
<tr>
<td>Sans Serif</td>
<td>&lt;$paratext&gt;</td>
<td>Indicates building block strings or output (for example, Maker Interchange Format output).</td>
</tr>
<tr>
<td>Sans Serif Bold with Arrows ( &gt; )</td>
<td>File &gt; Open</td>
<td>Indicates menu selection and menu choice (select the File menu, then select the Open menu choice).</td>
</tr>
</tbody>
</table>

Mistakes Were Made...

We’ve tried to make this book as accurate as possible. However, there’s the possibility that we were, well, wrong about something. Some features in FrameMaker also may have changed (or bugs may have been fixed) since this book was published. For changes and errata, visit:

Chapter 1: Why FrameMaker?

Adobe FrameMaker is the workhorse that technical communicators depend on year after year. FrameMaker is intended for creating complex documents, especially material full of technical information, references and numbering. Examples of this are:

- Technical documentation—user guides, installation guides, system administration guides, reference guides, and training materials
- Dissertations and other long academic publications
- Nonfiction books, especially third-party documentation (including this book!)
- Legal and financial documents, such as prospectuses
- Directories
- Catalogs
- Long documents and documents with a long life cycle

If you create these and similar technical documents, your software requirements are different from someone who produces short, graphics-intensive documents such as brochures, newsletters, or annual reports. For technical publishing, stability and reliability are critical, especially as documents get longer. Having a document crash because it exceeds 100 pages or contains too many graphics or cross-references is unacceptable, especially in an environment where books of 200 or 2,000 pages are quite common. FrameMaker provides a stable, reliable environment in which to create and manage these types of documents.

Most likely, though, you’re hoping for something more than an application that doesn’t crash too often. FrameMaker includes many features that are important for anyone working with long documents in a graphical what-you-see-is-what-you-get (WYSIWYG) environment, shown in the following figure.
FrameMaker 11 Strengths

Highlights of FrameMaker’s strengths include the following:

- **Consistent, repeatable, and maintainable formatting.** FrameMaker’s templates make it possible to create different documents with the same look and feel. Templates ensure that formatting is consistent from one document to another, and you can quickly copy updates from file to file. Instead of manual reformatting, you apply the template across affected documents, and FrameMaker changes formatting and repaginates automatically.

- **Complex document management.** Equations, variables for text, conditional text, and many other features help you create and maintain complex documents. In most cases we recommend setting imported graphics to automatically update when the referenced file is changed.

- **Stability.** FrameMaker is a stable, reliable application. It maintains your content, references, and numbering so that you can focus on content.
• **Long-document management.** FrameMaker provides strong support for managing pagination, tables of contents, and indexes in books. This lets you process multi-volume books, dozens of chapters, and thousands of pages without having to worry about the accuracy of numbering. To rearrange the order of chapters in a book, you drag and drop the files to their new locations and then update the book. FrameMaker automatically changes the pagination to reflect the new order, changes the chapter numbers as necessary, and updates the table of contents and index.

• **Cross-media publishing.** FrameMaker can serve as the engine or as a component of a very sophisticated publishing system, in which you create print, Portable Document Format (PDF), Extensible Markup Language (XML), Hypertext Markup Language (HTML), and various help formats from a single set of documents. This single-source publishing makes it possible to write content once and then publish information in several different media.

• **Change management.** FrameMaker supports WebDAV, which lets you set up a version control system on a web server. Given a library of very large books, often with multiple authors collaborating on a single document, change management becomes a critical issue.
You’ll find many superficial similarities between FrameMaker’s feature set and other desktop publishing applications. Only FrameMaker, however, is designed for long-document publishing; its document-management features are robust and reliable. Highlights of FrameMaker’s document-management features include the following:

- **Style sheets.** Most word-processors and desktop publishing packages provide style sheets for paragraph formatting, but FrameMaker takes this concept much farther. A FrameMaker file includes style sheets for paragraphs, characters, tables, cross-references, variables, master pages, object styles and several other items. These style sheets (often referred to as *tags*), are stored in catalogs, which can be imported from one file to another.

- **Books.** A book is a collection of files (chapters) in a particular sequence. FrameMaker manages the pagination and chapter numbering as information is added to and deleted from the book. A book can also contain grouped chapters, subdirectories of chapters, and other books.

- **Cross-references.** Using cross-references, you create a pointer from one part of the book to another (for example, see “Widgets” on page 13). FrameMaker automatically updates the page numbers and displayed content (for example, Widgets) when content changes. In PDF and other electronic outputs, cross-references are preserved as hyperlinks.

- **Tables of contents.** You can automatically generate a list of major topics in the document. After making changes to a document, updating the book automatically updates topic lists and page references.

- **Indexes.** You identify which terms to index by inserting markers in the documents. After that, the index is generated, sorted, and grouped automatically.

- **Tables.** Table support is very strong and includes the ability to save named table formats with settings for lines and shading.

- **Graphics.** FrameMaker includes a set of drawing tools for creating and managing graphics. You can also import external graphics and embed or link them into the document. Linked graphics are automatically updated in the FrameMaker file when the graphic changes. FrameMaker 11 introduces *object styles*, which allow rapid formatting and management of graphic objects, including lines, shapes and frames.

- **Conditional text.** You can use conditional text to identify information that belongs to a specific version of a document (for example, instructor-only material in a training guide). You can then create document versions that show or hide the tagged material.
Conditional text is an important component of any single-sourcing strategy because it lets you identify information that should be excluded from some output (most commonly, you have “print-only” and “online-only” content).

- **Variables.** These are useful for items that can change frequently. For example, you can create a variable called ProductName and use it throughout the document wherever the product name is needed. If the product name changes, you change the value of the variable, changing every occurrence of the variable throughout the document.

- **Modular text.** You can create small files that contain chunks of content and then reuse the chunks (text insets) into larger documents. Modular text lets you reuse chunks in multiple documents and maintain the information from a single file.

- **Equations.** FrameMaker includes an equation editor, which lets you create complex mathematical expressions.

- **Templates.** FrameMaker lets you import named styles from any other FrameMaker document. In most desktop publishing applications, templates are limited to paragraph style sheets and master pages, but in FrameMaker, template items include paragraph tags, character tags (for text range formatting inside paragraphs, such as italics), tables, master pages (page layouts), cross-reference formats, variable names and definitions, conditional text tag names, custom elements for equations, and more.

**Uses for FrameMaker**

It’s possible to use FrameMaker to create highly designed documents, such as annual reports and newsletters (where layouts change on almost every page), and glossy full-color publications. However, FrameMaker’s document-management features are much more useful in enforcing consistency across hundreds (or thousands) of pages.
At first glance, the logic behind FrameMaker’s features may seem a bit odd. Keep with it though, because the logic is there. FrameMaker was designed as a tool for long documents, so FrameMaker’s strength is in its ability to enforce consistency across your chapter, your book, and all of the content controlled by a given template (basically a set of naming conventions and formats). In short, if you act in ways that FrameMaker expects, FrameMaker will do all the heavy lifting for you, freeing you up to create or manage content instead of formatting it.

FrameMaker won’t solve all of your problems, but if you’re looking for a reliable, industrial-strength publishing tool that produces consistent output, it is the software for you.
Chapter 2: Creating Your First Document

After starting FrameMaker you can either create a new document or open an existing document. After that, you can start learning how to get around in the FrameMaker interface. This chapter explains how to start FrameMaker, create documents, and open them.

Starting FrameMaker

A shortcut for FrameMaker is installed in the Start menu after installation. Double-click on the desktop shortcut, or select Start > All Programs to find the FrameMaker 11 application.

Note: The exact path may vary, depending on installation choices and whether you installed FrameMaker 11 as part of the Adobe Technical Communication Suite.

The first time you start FrameMaker, you are prompted to activate the product, as well as sign in with your Adobe ID. Creating an Adobe ID or signing in is recommended, as it will give you options to collaborate with others via Acrobat.com among other things.

Next, you are prompted to select an interface.

Select one of the following options (you can change this selection later):

- **FrameMaker** (unstructured): Starts the “vanilla,” unstructured version of FrameMaker. Lets you work on unstructured documents without the structure features getting in the way. This book explains the unstructured interface.

- **Structured FrameMaker**: Starts the structured version of FrameMaker. Lets you create structured documents, work with enforceable content models like DITA and XML, and see the underlying code.
When you start FrameMaker, you are presented with a welcome screen.

You can choose to create new books or documents from this screen or from the File menu.

Removing the Adobe banner ads
The first few times you start FrameMaker, you might appreciate the resources shown below the Starter Page. When the appreciation fades, go to Edit > Preferences… > General to turn them off.

Setting Up a New Document
When you create a new document, FrameMaker names the file Untitled1.fm (additional documents are named Untitled2.fm, Untitled3.fm, and so on). You can save the document with a more informative name.

There are several ways to create a new document:
- Exploring the standard templates, then choosing one of those templates
- Using a file as a template
- Creating a blank document
- Saving an existing file under a new name
Exploring the Standard Templates

For each of the default templates, FrameMaker includes a preview and a feature summary. This information helps you determine whether a particular template will meet your needs. To examine the unstructured templates, follow these steps:


2. Click the Explore Standard Templates button. A list of templates is displayed with previews.

3. Click an item in the template list on the left to display a feature summary and preview for that template on the right. To see a sample document with placeholder text, click the Show Sample button.

4. To use a particular template, click the Create button. FrameMaker creates a new, untitled document by making a copy of the template file.

You can now save the document with an appropriate name and begin working.
Using a File as a Template

In addition to the standard templates, you can use any FrameMaker file as a template.

To use a file as a template, follow these steps:

1. Select **File > New > Document**, press **CTRL-N**, or click the New File button ( 
   ) on the Quick Access Bar. The New dialog box is displayed (see page 11).

Select the template by doing one of the following:

   - To find a standard FrameMaker template, double-click a folder in the Look In window and then double-click the template. You can display a preview of FrameMaker's standard templates by clicking the Explore Standard Templates button.

   - To use another file as a template, navigate to the directory that contains the file and double-click the file.

2. The new document is displayed.

When you create a new document from a template, FrameMaker makes a complete copy of the file. Any content stored in the original file is included in the new, untitled document (good for contracts or other boilerplate text).

Creating a template file with standard information, perhaps with variables can speed up editing of standard documents.

For more information about variables, see Chapter 10, “Storing Content in Variables.”
Creating a Blank Document

When you create a blank document, you can use default sizes, choosing portrait or landscape orientation, or you can create a custom page size. Even blank documents contain styles and other information from a default FrameMaker document.

To create a blank portrait or landscape document, follow these steps:

1. Select **File > New > Document** or press **CTRL-N**. The New dialog box is displayed (see page 11).
2. In the Use Blank Paper section, click the Portrait or Landscape button. The new document is displayed.
To create a document that uses a custom paper size, follow these steps:

1. Select **File > New > Document** or press **CTRL-N**. The New dialog box is displayed.
2. In the Use Blank Paper section, click the Custom button. The Custom Blank Paper dialog box is displayed.
3. Click a paper size in the Page Size drop-down list:
   - **Custom**: You specify the page width and height
   - **US Letter**: 8.5 inches wide by 11 inches tall
   - **US Legal**: 8.5 inches wide by 14 inches tall
   - **Tabloid**: 11 inches wide by 17 inches tall
   - **A3 Tabloid**: 29.7 cm wide by 42 cm tall
   - **A4 Letter**: 21 cm wide by 29.7 cm tall
   - **A5 Letter**: 14.8 cm wide by 21 cm tall
   - **B5 Letter**: 17.6 cm wide by 25 cm tall

4. Modify the margins as appropriate. Page margins are measured from the edge of the page to the edge of the text area, and can be modified later by changing the Master Pages.
5. To create a document with equal-sized columns, specify the number of columns you want in the Columns area. The default is 1. The Gap measurement determines the amount of space between the columns. After you specify the columns and gap value, FrameMaker automatically creates even columns.
6. Set the pagination. Most books use double-sided pagination and start with a right first page. If you specify single-sided pagination, only one master page is created (called Right); if you specify double-sided pagination, two master pages are created (Left and Right). For details, see “Switching from Single- to Double-Sided Pages” on page 267.
7. Click the Create button. Your new document is displayed.

**Tip**

To change the measurement units (for example, from inches to picas), select a measurement unit in the Units drop-down list at the bottom right. FrameMaker automatically converts the current measurements into the new units.

8. Modify the margins as appropriate. Page margins are measured from the edge of the page to the edge of the text area, and can be modified later by changing the Master Pages.
9. To create a document with equal-sized columns, specify the number of columns you want in the Columns area. The default is 1. The Gap measurement determines the amount of space between the columns. After you specify the columns and gap value, FrameMaker automatically creates even columns.
10. Set the pagination. Most books use double-sided pagination and start with a right first page. If you specify single-sided pagination, only one master page is created (called Right); if you specify double-sided pagination, two master pages are created (Left and Right). For details, see “Switching from Single- to Double-Sided Pages” on page 267.
11. Click the Create button. Your new document is displayed.

**Using an Existing File**

Instead of using a document as a template and creating a new file, you can save the template file with a new name to make a copy. To use an existing file, follow these steps:

1. Open a file that has the correct formats.
2. *(optional)* To delete the content in the file, highlight all the information in the file by selecting **Edit > Select All in Flow**, then press the DELETE key.
3. Select **File > Save As** and save the file with a new name.

You now have a new file and can begin editing it. However, using this method is more prone to operator error than creating a new document from the same file using the **File > New** command.

**Opening, Saving, Closing, and Printing Documents**

FrameMaker includes standard open, save, close, and printing commands:

- To open a file, select **File > Open**, then locate the file you want.
- To close a file, select **File > Close**.
- To save a file, select **File > Save**, or select **File > Save As** to save the file with a different name.
- To print a file, select **File > Print**.

Files created in earlier versions of FrameMaker open in newer versions. For example, a file created in FrameMaker 10 opens in FrameMaker 11. However, you cannot open a FrameMaker 11 file in earlier versions of FrameMaker. To move a file “back” to an earlier version of FrameMaker, save the file as Maker Interchange Format (or MIF), then open the MIF file in the older version. You will lose features that are not supported in the older versions, but the files usually open cleanly. If you have authored in multiple languages or in languages FrameMaker 11 supports with Unicode, you will need to check your file carefully for changes.

**Tip** FrameMaker 11 also provides a Save As Document 10.0 feature, which lets you save files in FrameMaker 10 format directly instead of using MIF as an intermediate format. This feature could be useful if you are working in a mixed version 10/version 11 environment, but you will have to check your files carefully, especially if you use features unique to FrameMaker 11.

**Understanding the Document Window**

You view and edit your document in the document window. A dotted line indicates the area in which you can insert content. (If you do not see the dotted line, select **View > Borders** to display it.)

At the bottom of the document window, a **status bar** displays information about the current document. By looking at the status bar, you can find out the following information:

- Flow tag, paragraph tag, character tag, and conditional text tag for the currently selected item. (In structured documents, the element name is listed instead of the paragraph and character tags.)
- Current page number and total page count.
- Whether the file has been modified since you last saved it.
- The current percentage zoom at which the file is being displayed.
Chapter 2: Creating Your First Document

Changing the Zoom Settings

To change the size at which a document is displayed, you can zoom in or zoom out. The big and little Zs on the status bar let you zoom in or out one step at a time.

Click the "+" to zoom in. The text gets bigger, as shown next. Notice that the zoom value shown changes to the new setting.

Here is the resulting view:

Zoom Level Bug

As of FrameMaker 11.0.1.382, the Zoom Level control displays only the 25%, 50%, 80% and 100% zoom levels. This is a bug and is likely to be fixed in an update sometime soon. You can still use the + and - buttons, as well as type in a percentage and press the ENTER key to change views.
FrameMaker provides four zoom settings. You cannot add more settings, but you can change the current view to values anywhere between 25% and 1600% by typing a number into the zoom menu. To do this:

1. Click on the zoom percentage to highlight the number.
2. Type in the zoom setting you want and press ENTER or TAB. The document is immediately changed to that zoom level.

Displaying Nonprinting Items in the Document Window

You can turn on and off the display of several items in the document window. They are as follows:

- **Borders.** With borders on, the edge of text frames, table cells, and the like are indicated with dotted lines.
- **Text Symbols.** With text symbols on, tabs, end-of-paragraph symbols, markers, and other nonprinting characters are displayed on screen. These are extremely useful when editing or searching for specific items.
- **Rulers.** With rulers on, measurements are shown on the top and right of the document window.
- **Grid Lines.** With grid lines on, a grid pattern is shown to help you align objects on the page.
- **Hotspot Indicators.** With hotspot indicators on, you’ll get a visual indicator of the graphical objects you’ve set to act as click-able areas.

**Tip**

- Another item, one that “prints,” is **Line Numbers.** These are also helpful for reviewers. Line numbers help when following irregular spacing and text frames. Line numbers are required for legal pleadings in some jurisdictions.

The commands to toggle each of these options are in the View menu. FrameMaker uses many different nonprinting symbols. Though non-printing, these symbols may cause the document to reflow slightly when displayed in the document. This can affect your pagination. The following table lists nonprinting text symbols.
## Table 2-1. Text Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab.</td>
<td>Indicates a tab character. Keep in mind that tabs do not move text unless a tab stop is defined for that paragraph. For details, see &quot;Setting Tab Stops&quot; on page 118.</td>
</tr>
<tr>
<td>End of paragraph symbol</td>
<td>Indicates the end of a paragraph. When you press ENTER to end a paragraph, FrameMaker inserts this symbol.</td>
</tr>
<tr>
<td>End of flow symbol</td>
<td>Indicates the end of the content in the current flow. As you add more content, the end of flow symbol always stays at the end of the text. You cannot remove this symbol.</td>
</tr>
<tr>
<td>Forced return</td>
<td>Indicates a forced line break. Press SHIFT-ENTER to insert a forced return.</td>
</tr>
<tr>
<td>Hard space</td>
<td>Indicates a nonbreaking space (inserted by pressing CTRL-SPACE), which does not allow a line break to occur at that location.</td>
</tr>
<tr>
<td>Discretionary hyphen</td>
<td>Indicates a location at which the word can be hyphenated if necessary, in addition to the hyphenation points defined in the dictionary. Press CTRL-HYPHEN or ESC HYPHEN SHIFT-D to insert a discretionary hyphen. Discretionary hyphens are shown above the text.</td>
</tr>
<tr>
<td>Suppress hyphen</td>
<td>Indicates a location at which the word cannot be hyphenated, even if the dictionary allows hyphenation there. Press ESC N S to suppress hyphenation for a word and insert a suppress hyphen symbol. The suppress hyphenation symbol is displayed under the text.</td>
</tr>
<tr>
<td>Anchor for table or anchored frame</td>
<td>Indicates the location at which a table or anchored frame is anchored to a paragraph.</td>
</tr>
<tr>
<td>Marker</td>
<td>Indicates the location of a marker, which contains hidden, nonprinting text. Markers are used for several things, including index entries. FrameMaker automatically inserts markers for cross-references and conditional text, so you should not delete a marker unless you are certain it isn’t needed. Markers can occur anywhere in text, including in the middle of a word. They are usually easier to maintain if you put them at the beginning or end of a word, and you might consider applying a character tag to them to color code them, making it easier to locate and identify them.</td>
</tr>
</tbody>
</table>
Changing View Options

The view options let you set measurement units, page options, and more. To change your view options, follow these steps:

1. Select the View > Options… command. The View Options dialog box is displayed.
2. Set the page scrolling you want. Your choices are as follows:
   - **Vertical**: In the document window, pages scroll vertically. (This is standard behavior in most word-processing and publishing applications.)
   - **Horizontal**: Pages scroll horizontally.
   - **Facing Pages**: Pages are displayed in spreads, with the left and right pages displayed in the document window together.
   - **Variable**: Pages are displayed depending on how the document is zoomed. If facing pages fit in the window, they are displayed; if not, pages scroll vertically.
3. Set the display units with the Display Units and Font Units drop-down lists. The font units are used for font size, leading, and space above and below paragraph. Display units are used for all dialogs and panels.
4. In the Snap section, you can set the spacing for the snap grid, as well as the increment (in degrees) used for snapping a rotated object.
5. In the Display section, Rulers lets you turn display of rulers on and off, as well as set the units and increments displayed.
6. In the Display section, check the items you want to display. Unchecking the Graphics checkbox speeds up scrolling by temporarily displaying your graphics as gray boxes.
7. Click the Set button to save and apply your changes.
FrameMaker Interface Options

Workspaces

Beginning with FrameMaker 9, FrameMaker began to move to the Adobe OWL (Adobe OS Widget Library) interface. This means that FrameMaker now looks much more like Photoshop, Illustrator, and the majority of other Adobe applications. The advantages of this interface include a dramatic reduction in modal dialog boxes, those dialogs that must be dismissed before continuing. Additionally, the visibility and position of toolbars and panels within your workspace is stored, and can be recorded within the Workspaces option in the upper right corner of the application. Workspace files can be shared, and are stored in C:\Program Files (x86)\Adobe\AdobeFrameMaker11\fminit\WorkSpaces\UnStructured)

Toolbars

FrameMaker provides eight toolbars at the top of the main window, and some have quite a few options. If you like using buttons instead of keyboard shortcuts, check out View > Toolbars to show or hide as needed. The buttons each have tooltips to help you navigate the options available.

Toolbars can be docked in one or more rows under the menu bar, or can be dragged into the main document area to create independent floating toolbars.

Figure 2-1. Floating toolbars

Figure 2-2. Docked toolbars
FrameMaker Interface Options

Getting Started with FrameMaker

To re-dock toolbars, reset your workspace or drag the handle of the toolbar into the toolbar region below the menu bar until you see a blue bar. The blue bar indicates a legal position for the toolbar.

Developers also provide FrameMaker enhancements for specific workflows and functions. For more information see Appendix A, “Third-Party Tools and Plug-Ins.”

Document Tabs

FrameMaker 11 can display open documents as a series of stacked windows, or as a series of tabs across the top of the document view. When viewing tabs, you can click on a tab to move that file to the front of the working files. When many files are open, you may see a double chevron icon ($) appear to the right of the tabs. Clicking on the chevrons displays a list of open documents, allowing you to quickly navigate to documents whose tabs are currently hidden. To quickly configure display of open documents, select the Arrange Documents ( ) button.

Tip

The CTRL-TAB key will cycle through open documents. This is effective when you have only a handful of documents open in FrameMaker.

Panels

Most configuring of text and FrameMaker objects occurs within panels. Similar to toolbars, panels can either float or dock to the edges of the application frame. Both floating and docked panels can expand to display contents, or collapse to icons, allowing toggling of panel display, as shown in the following figure. To expand or collapse panels to icons, click the double arrow in the upper right corner of the panel.
Understanding File Configuration and Preferences

FrameMaker files normally use the .fm extension. FrameMaker book files (more on those in Chapter 17, “Setting Up Book Files”) normally use .book.

A FrameMaker document file is self-contained; it includes all of the formatting or structure information needed to display and print the content. Unlike some other applications, FrameMaker files do not refer to a separate template file; the template information is embedded in each individual document file. For details, see Chapter 5, “Templates” on page 89.

When you add graphics to a document, you can either link or embed the graphic. When you link a graphic (referred to as Import by Reference), you insert a pointer from the
FrameMaker file to the graphic. This pointer is basically just a file name and path with a small graphic for screen representation, so it's very compact. If you embed a graphic (referred to as Copy into Document), you insert the entire graphic into the FrameMaker file, so the FrameMaker file grows accordingly. It is common for savvy FrameMaker users to link to all graphics within a project, rather than embedding them. However, screenshots, whose FrameMaker representation can be the size of the referenced file itself are a possible exception. As screenshots are likely recaptured and not edited, some authors prefer to copy screenshots directly into their documents.

To prevent two people from working on the same file simultaneously, FrameMaker provides a feature called network file locking. If network file locking is active, opening a file creates a .lck file ("lock" file, not "ick" file). If a second person attempts to open the locked file, FrameMaker displays an error message:

You have three choices:

- **Open for Viewing Only**: Opens a read-only version of the file. You cannot make any changes to this file.
- **Open Copy for Editing**: Creates an untitled copy of the file. You can make changes in this file.
- **Reset Lock and Open**: Removes the lock and lets you edit the file. Use this option only when you are certain that nobody else is using the file (for example, if your computer crashed and left incorrect locking information on the server).

To activate network file locking, follow these steps:

1. Select **Edit > Preferences… > Global > General**. The Preferences dialog box is displayed.
2. Check the Lock File on Network checkbox.
3. Click the OK button to save your change.
Chapter 2: Creating Your First Document

Remember  Network file locking is turned on by default when you install FrameMaker. Keep in mind, though, that each user must have network file locking activated in their copy of FrameMaker for the feature to function properly and that the .lck file relies heavily on the “honor system” for enforcement.

In a larger group (or if you have people working on the files who are not on the same network), the basic file security provided by file locking may not suffice. If this is the case, you can use WebDAV. FrameMaker supports file check-in and check-out on a WebDAV server. See Chapter 29, “Using Files with a Content Management System (CMS),” for details. You can also use source control systems to manage FrameMaker files.

Handling Missing Fonts

To display text, FrameMaker uses fonts that are installed on your system. When you open a file, any fonts used in the file, but currently unavailable to FrameMaker are identified and listed in the console window. By default, FrameMaker performs only a temporary font replacement. You might have a situation where a consultant’s or author’s computer lacks fonts required for a document, but the final production computer has the necessary fonts installed. In this scenario, you want FrameMaker to keep track of the missing fonts and replace them only temporarily while the file is being edited. In other cases, you may want a permanent font substitution. You might, for example, receive a file from another company, which uses fonts that you do not have and don’t plan to install. In that case, you probably want to get rid of the fonts so that you don’t get the missing fonts message every time you open the file.

Caution  If some characters in your FrameMaker file are displayed as boxes, question marks, or other strange characters, the missing font may have more characters than the font being substituted. (This is common when a Unicode font is missing and a non-Unicode font is substituted.)

In this case, make sure you have a font that can display all the characters correctly before you allow FrameMaker to permanently substitute a different font.

Font substitution (for both temporary and permanent substitutions) is specified in the maker.ini file. To change the substitution font, see “Changing the Substitution Fonts” on page 564.

To toggle your missing font setting, follow these steps:

1. Select Edit > Preferences… > Global > General. The Preferences dialog box is displayed (see page 23).
2. Check or uncheck the Remember Missing Font Names checkbox.
3. Click the OK button to save your change.
To remove missing fonts from a file, follow these steps:

1. In the Preferences dialog box, turn off Remember Missing Font Names as described in the preceding steps.
2. Open the problem file.
3. Save the file. The missing fonts are replaced with the fonts specified in the maker.ini file. See “Changing the Substitution Fonts” on page 564.
4. (optional, but recommended) Return to the Preferences dialog box and turn on Remember Missing Font Names.

The fonts should now be removed from the file. There may be a few cases where additional measures are needed to remove font calls:

- Fonts may be used in various catalogs, on master pages, or on reference pages. Untagged font properties and text lines may also contain font calls that are difficult to find. Solution: Save file as MIF and search for the font name using a text editor. For details, see Appendix E, “Maker Interchange Format.”
- Fonts may be specified in placed meta graphics or vector graphics files. Solution: remove the graphics one at a time and reopen the FrameMaker file to identify the culprit graphic file. If there are many graphics, consider splitting the file and saving as two or more files for testing, then opening each segment to help narrow down the location of the offending graphic file.

**Using the Fonts Panel**

You can track down many font issues using the Fonts panel. To replace a font in your document using the Fonts panel, follow these steps:

1. select **View > Panels > Fonts**. The Fonts panel is displayed.
2. Select the Toggle Missing/All Fonts button ( or ) if needed, and select the font to replace.
Chapter 2: Creating Your First Document

3. Select the Replace button ( ). The Replace Font panel is displayed.

4. Do one of the following:
   - Select a replacement font and click the Apply button.
   - Select an instance of the font and click the Go To Location button ( )
   - Select the Refresh button ( ) for an updated view of locations.

5. In the Fonts panel select the Refresh button ( ) to see the results of your font replacement.

Organizing Directories and Files

Although many companies establish rules about how to store files and set up directories to manage content, a surprising number do not. If you need to set up a new organization for your documentation library, this section provides some suggestions on how best to manage the files.

The first principle of organizing documents is that a book should have its own directory. Moving the directory (and any associated subdirectories) should move all of the contents of the book. For instance, you can set up a directory organization for a book that includes the book file, chapter files, and graphics in a simple organization.

```
CookingBook
  baking.fm
  chopping.fm
  cooking.book
  graphics
    food_processor.eps
    knife.tif
    pan.tif
  intro.fm
```
We recommend against naming chapters by their numbers; for example, chap01.fm, chap02.fm, and so on. If you move chapters around, you will either have a big renaming job or have chapters whose file names don’t match their numbers. Instead, name chapters by context or subject: production_editing.fm, workflow.fm, and so on.

Putting referenced graphics in a subdirectory makes it easier to keep track of them and to separate the graphics from the FrameMaker content files. Creating subdirectories for each chapter can be appealing when you have lots and lots of graphics, but again, avoid naming these directories by chapter number because of the naming mismatch that will occur if you rearrange chapters. For longer books, consider using a prefix for each chapter so that the graphics sort nicely into chapter groups.

Files that are reused across chapters and especially across books present a problem. Consider creating a special “shared” folder in the book folder or one level up from the book folder if you want to share across different books. Keep in mind that you must remember to send the shared folder in addition to the book folder if you ship the files to someone who cannot access them from your network. Be wary of deep nesting across networks—long path names can cause issues with placed graphics.

If you move files from one root drive to another, it is likely that relative links will change to absolute links. Be aware of this when planning location of working files and network graphics.

To assist in moving all files referenced by a book, consider plug-ins or scripts which will do the searching and copying for you. The late Bruce Foster wrote an excellent Archive utility which worked well up through version 9. You can find ExtendScript and other archiving resources on Adobe’s TechComm blog, blogs.adobe.com/techcomm/ or at Rick Quatro’s website, www.frameexpert.com.

**Saving File Information with XMP**

You can save file information, such as the author, keywords, and title, along with your file. This information is saved as metadata, or information about the document. The file information you save is stored in a special format called Extensible Metadata Platform, or XMP. XMP allows you to view metadata without opening the file. You could, for example, define some file information and save your FrameMaker file. An XMP-compatible application or browser can access the XMP data stored for your FrameMaker file, even if the FrameMaker application is not available.
Chapter 2: Creating Your First Document

If you make a PDF file from your document, the file information you specify can also be viewed in Adobe Reader.

To set up file information, follow these steps:

1. Open the file or book for which you want to save file information.
2. Select File > File Info. The File Info dialog box is displayed.
3. Type in the information you want to save. You can fill in any or all of the available fields.
4. Click the Set button to save your changes with this file.

After setting file information, the data you provided is included as XMP metadata when you save the file.

For more details about XMP, consult Adobe’s web site (www.adobe.com/products/xmp/).

Implementation of XMP varies, so verify that the XMP data is recognized as you would expect.

Setting Automatic Backup and Save Features

FrameMaker provides two complementary features that save files automatically:

- **Automatic save.** While you work in FrameMaker, an autosave file (.auto) is created periodically. If you exit FrameMaker normally, the file is deleted. However, if your system crashes (which means you didn't have a chance to close FrameMaker properly), the file is preserved. When you reopen the file you were working on, FrameMaker offers to open the .auto file, which might contain more recent information.

- **Automatic backup.** When you save the working file, a .backup.fm file is created. Backup files reside in the same directory as the working file.

To set your file backup options, follow these steps:

1. Select Edit > Preferences… > General. The Preferences dialog box is displayed (see page 23).
2. To set automatic backup, check the Automatic Backup on Save checkbox.
3. To set automatic saving, check the Automatic Save checkbox, then specify the interval at which you want the file saved. (The default is 5 minutes.)
4. Click the Set button to save your changes.

**Note** Sometimes FrameMaker saves a crash recovery file (.recover) when a crash occurs. That file might contain more up-to-date information than the .auto or .backup files. We recommend that you inspect the .recover, .auto and .backup files to see which has the most appropriate content.
Switching Between Structured and Unstructured Interfaces

To switch between structured and unstructured FrameMaker, you must select the new interface, close FrameMaker, and reopen it.

To change interfaces, follow these steps:

1. Select Edit > Preferences… > Global > General. The Preferences dialog box is displayed (see page 23).
2. In the Product Interface drop-down list, select the interface you want to switch to and click OK. You’ll be reminded that you must restart FrameMaker for the changes to be applied.
3. Save all your open files.
4. Exit FrameMaker.
5. Restart FrameMaker. The product is started and displays the interface you selected.

File Naming Conventions

Note FrameMaker 11 is only available on the Windows platform. The following section is included as written for FrameMaker 8. It is intended as reference for users of earlier versions of FrameMaker.

You can open a FrameMaker file created on one platform’s version of FrameMaker in the other platform. For example, if you create a file in FrameMaker for UNIX, you can open that file in Windows FrameMaker without any trouble.

Remember The version numbers have to match; you cannot open a FrameMaker 8 file in FrameMaker 7 unless you go through Maker Interchange Format 7 (MIF 7) or save to FrameMaker 7 format—see page 15.

To ensure that files transfer seamlessly from one platform to another, you need to use file names that work on all platforms. Here are some common tips that will help you create well-behaved file names (the platform that requires the limitation is listed in parentheses):

- Do not use spaces in file names (UNIX).
- Do not use slashes or backslashes in file names (UNIX, Windows).
- Use a file-name extension (.fm or .book) to ensure files are recognized by the application and the operating system (Windows).
FrameMaker provides a preferences setting to help you create compatible file names. If you attempt to create a file with a name that will not work on the target platform, a warning message is displayed.

To set cross-platform file naming, follow these steps:

1. Select **File > Preferences... > General**. The Preferences dialog box is displayed (see page 23).

2. In the Cross-Platform File Naming drop-down list, click the platform to which you plan to send the files. For example, if you’re working under Windows but will need to use the files on the UNIX platform, click UNIX.

3. Click the Set button to save your change.

The next time you save a file, FrameMaker will check the file name for compatibility with the platform specified in the preferences. If any problems are detected, an error message is displayed:

Click the OK button to save the file with the incompatible name. Click the Cancel button to return to the Save dialog box and specify a different name.
# Index

## Symbols

- \( \leq 0 \) 561
- \( \perp \) See anchors
- \( <> \) See angle brackets
- \( ' \) See apostrophes
- \( * \) See asterisks; stars
- \( \backslash \) See backticks
- \( \cdot \) See bullets
- \( \backslash b \) See bullets
- \( ^\^ \) See caret
- \( : \) See colon
- \( \dagger \) See daggers
- \( \$ \) See dollar signs
- \( \dagger \) See double daggers
- \( \$ \) See end of flow symbols
- \( \¶ \) See end of paragraph symbols
- \( <> \) See forced returns
- \( ? \) See question marks
- \( " \) See quotation marks
- \( ; \) See semicolons
- \( _\_ \) See suppress hyphens
- \( > \) See tabs
- \( \backslash t \) See tabs
- \( </> \) 96, 372, 561

## Numerics

- 3D objects 305–308

## A

- \( <a+> \) 561
- Acrobat Distiller 416
- active area, hypertext link 509
- ActiveIX 388
- actual text property 284
- adding
  - columns, text flow 259
  - columns/rows to table 164–166
  - files to book files 341
- Adobe
  - Acrobat Distiller 416
  - FrameMaker. See FrameMaker
  - Illustrator 76
  - PDF Creation Add-On 416
  - reporting bugs to 555
  - RoboHelp 552
  - Technical Communication Suite 416, 552
- Adobe PDF Creation Add-On 416
- Advanced sheet 126
- Alert commands 514
- alert messages 512
- algebra, matrix 516
- aligning
  - See also positioning
  - anchored frames 270–272
  - baselines 263
  - columns, text 260
  - equations 528
  - paragraphs 116
  - table cells 129
  - tables 161
- all caps 121
- alphabetical
  - list of markers 399
  - list of paragraphs 398
  - numbering 353
- \<$\text{alphabetics}>\) 390, 558
- alternate text 283
- \<$\text{ampm}>\) or \<$\text{AMPM}>\) 204, 558
- anchored frames
  - See also graphic frames
  - attributes 284
  - cropping 271
  - finding 41
floating 271
inserting 270
object properties for 283
positioning 270–272
shrink-wrapping 280
anchoring graphics 269–285
anchors 18, 156, 158
AND, ANDNOT operators 477
angle brackets 125, 139, 557
apostrophes 52, 188
applying
character tags 143–145
color to text and objects 447
condition tags 463–465
master pages 220–221, 237
paragraph tags 111–114
templates 91–92
arcs, drawing 311
arranging
See also moving; rearranging
graphic objects 327–332
arrowheads 318
articles, threading PDF 422
As Is properties 146
assigning master pages 220–221
asterisks
See also stars
character overrides 151
in footnotes 68
search wildcards 38
attributes for anchored frames 284

authoring
structured versus unstructured 85
authors
file information 27
index of 403
automated numbering. See autonumbering
automatic
backup and save 28
cross-reference updates, preventing 194
line breaks, in equations 531
automating FrameMaker with ExtendScript 485
automation with ExtendScript 485
autonumbering
See also pagination
building blocks for 125
bullets 135
cautions, notes, warnings 136
chapter and volume numbers 139
counters 124
documenting 109
documentation 109
eof story 142
headings 141
numbered steps 136
paragraphs 124
repeated text or symbols 134
tables 161
tables of contents 376
autonumbering streams 109
<autorange> 392, 558
Autorun View 487
Auto-Text plug-in 554

B

backslashes
in cross-references 188
escaping special characters 383
backticks 188
backup, automatic 28
backward compatibility 15
balancing columns, text 260
baselines
shifting vertically 580
synchronizing 263
Basic sheet 116
Bezier curves, drawing 311
bitmap images 277, 287
blank
counters 139
documents, creating 13
pages 222, 412
paragraphs 369, 541
bleeding thumb tabs 232–236
BMP files 286
body
pages 219
rows 156, 165
book error log 349
book files
See also books; documents; files
adding files to 341
creating 339
cross-references, updating in 193
non-FrameMaker files in 342
numbering in 352–361
printing files from 362
rearranging files in 346
removing files from 346
renaming documents 347
shortcuts 346
spell-checking 362
updating 348–351
book palette. See book files
book window 340
BookHeadings reference page 436
bookmark, PDF files 420
books
   See also book files

C

calculus symbols 521
camera-ready. See printing
capitalization 106, 121
carets 39
Carmen Publishing
   ImpGraph 269
   TableCleaner 72, 182
catalog settings, updating 581
cautions format 136
CDR files 286
cells. See table cells
CGM files 286
change bars
   character tags 152
color, adding 448
   paragraph tags 120, 142
   using 59–60
changes, tracking 55–63
changing default fonts 564
<$chapnum>
in book files 353
in cross-references 191
overview 558
in paragraph tags 139
in tables of contents 372
in variables 205

comparing versions 61–63
saving as rudimentary HTML or XML 431
borders
   displaying 17
document 256
   style 312
boxes. See text frames
broken cross-references. See unresolved
cross-references
bug reports 555
building blocks
   autonumbering 125
cross-reference 189–191
reference 557–562
table of contents 372
variables 199
bullets 35, 135, 561
Button Matrix command 516

Chapter Number variable 205
chapter numbers
   in book files 355, 357
   building block for 139
displaying 125
<$char_tag> 372, 561
character catalog 143
Character Designer 145
character format, finding 40
character tags
   applying 143–145
   As Is properties 146
   baseline shift 579
   creating 147–150
deleting 151
finding 40
mapping for HTML conversion 433, 437
modifying 145–147
overrides 147
removing 151
renaming 148
tips 101, 152
updating globally 149
   vertical baseline shift, adding 580
characters. See special characters
checkboxes 148
Index

checking spelling. See spell-checking
circles, drawing 311
clickable text 509
clipboard 42
close case 39
Close All Hypertext Windows command 516
Close Current Window command 516
closing documents 15, 346
CMYK color model 445
colons 381, 384, 558
color
  applying to text and objects 447
catalog 94
  changing background of 3D objects 307
  CMYK model 445
  condition indicators 469
  creating custom 451
  cross-references 448
  definitions 449–451
deleting 456
  extra colors in catalog 579
  for graphic objects 312
  hiding 455
  HLS model 445
  in PDF files 457
  inconsistent settings in book 351
  knock out 450
  libraries 445, 452
  naming new 451
  for online output 457
  overprint 450
  PANTONE 453
  process 413, 445
  renaming 454
  RGB model 287, 445
  saturation 452
  separations 415
  showing 455
  spot 413, 447
text 120, 448
tint 312
viewing 455–456
color catalog 443
columns, table
  See also rows, table; table cells; tables
  adding 164–167
  aligning 260
balancing 260
deleting 164–167
resizing 157, 166–167
rulings 162
selecting 56, 157
shading 163
sorting by 175
width, specifying 167
columns, text
  aligning 260
gap between 249, 259
columns, text flow
  adding 259
command characters 383
comparing documents and books 61–63
composite reports 61
Computer Graphics Metafile files. See CGM files
computing in equations 532
condition tags
  applying 463–465
  condition indicators 466
  creating 469–470
  deleting 470
  displaying 210
  list of 400
  overview 461
  removing 465
  removing conditions from text 466
  Show as per Condition 473
  Show as per Expression 474
  variables 211
conditional text
  alternatives to 468
  choosing method for showing 472–474
  color in 448
  dimensions in 472
  finding 41
  inconsistent settings for 351
  keyboard shortcuts 465
  operators 477
  overview 461
  planning 467–469
  showing/hiding 471
<$condtag[condtag]> 558
<$condtag[hitag,... lotag,nomatch]> 208
configuring text options 52
configuring WebDAV 546
connecting text flows 253
container documents 533
contents, tables of. See tables of contents
continuation, table 206
control
files 110
points 322
conventions, text xxxii
conversion
filters 70
tools 552
converting
cross-references to text 197
tables to text 181
text from other applications 70
text insets to text 544
text to table 178–180
variables to text 214
copied text and formats, finding 41
copy editing 77
copyfitting
filling columns 261
master page overrides 237
printer driver, effect of changing 415
production edit 77
resizing text frames 251
copying
paragraph tags 129
special characters from Windows Character Map 37
text 70
text frames 252
CorelDraw graphics 286
corners, smoothing in graphics 322
counters 124–126
crash recovery file 28
creating
See also adding; inserting
book files 339
character tags 147–150
colors, custom 451
cross-references 185
documents, new 10–15
generated lists 396
graphic objects 310
hypertext links 507–509
image maps 511
index files 380–381
master pages 219–224
MIF files 577
paragraph tags 129–132
PDF files 419
pop-up messages 512
table tags 164
tables 155–158
templates 93–98
text insets 540–542
user variables 212
Creation Date variable 203
<$creationtime> 212, 558
crop marks 414
cropping
anchored frames 271
graphic objects 326
cross-platform
file names 29
graphics 288
cross-references
See also hypertext
building blocks 189–191
color, adding 448
converting to text 197
creating 185
definitions 187
deleting formats 192
definitions 187
examples 192
external, list of 400
finding 41
forcing updates 194
formats 187
formatting 188
HTML mappings 434, 438
macros 438
overview 183
paragraph-based 185
preventing automatic updates 194
spot references 186
unresolved 195–197, 351, 402
updating 193–195
versus hypertext 506
CSS files 439
CudSpan Tools 553
curly quotes 52
<$curpagenum> 205, 558
Index

Current Date variable 203
Current Page Number variable 205
<$currenttime> 212, 558
curves, drawing 311
custom markers 399
custom master pages 221
customizing
  hyphenation 49–51
tables of contents 368
text flows 253–267

d

daggers 68
dashed lines 312, 319
dashes 35
database publishing 82, 555
Datazone Ltd. Miramo 82, 555
date variables 203
<$dayname> 204, 558
<$daynum> 204, 558
decimal tab stops 118
Default Font sheet 119
default fonts, changing 564
<$Default Para Font> 372, 561
<$defaulttitle> 441, 558
deleting
  character tags 151
colors 456
  condition tags 465
cross-reference formats 192
equations 529
files from book file 346
graphic objects 315
index entries 384
master pages 243
paragraph tags 132
table columns, rows 164–166
table tags 177
tables 157
text frames 252
user variables 215
delimiters, equation 521
deliverables. See documents
development (parallel, serial, modular) 82
dialog boxes, special characters in 102
dictionaries
  document 44, 48
  language 120
  personal 43, 47
  preferences 120
  site 44
dictionary-style running header/footer 209
dimensions, conditional text 472
directories, organizing 26
disconnections text frames 265
discretionary hyphens 18, 51
display
  equations 522
  units 19
displaying
  condition tags 210
  Equations palette 519–521
  grid lines 17
  nonprinting items 17
  rulers 17
distributing graphic objects 329
document
  See also documents
  borders 256
  comparison reports 61
  conventions xxxii
  dictionaries 44, 48
  formats. See templates
  properties. See templates
  window 15
documentation plan 74
documenting templates 109
documents
  See also book files; document; files; managed
documents
  all in book 346
  backward compatibility 15
  blank 13
  closing 15
  comparing versions 61–63
  container 533
  creating new 10–15
  editing 76
  formatting 77
  opening 15
  planning 74
  printing 15, 78, 408–415
Index

read-only 513
renaming 347
saving 15
single- or double-sided 267
structured versus unstructured 85
template documentation
tracking changes in 55–63
view-only 505
word count 58
dollar signs 39, 557
dot leaders 374
double daggers 35, 68
double-sided documents 267, 411
DPI settings 275
dragging. See moving
drawing tools for graphic objects 310–315
duplicating. See copying

dot leaders 374
double daggers 35, 68
double-sided documents 267, 411
DPI settings 275
dragging. See moving
drawing tools for graphic objects 310–315

ingredients 384
embedded
indexes 77–78
 tables of contents 367
EMF files 286
Encapsulated PostScript files. See EPS files
end of
 flow symbols 18, 254
 paragraph symbols 18
 story graphic 142
<$endrange> 382, 385, 558
Enhanced Metafile files. See EMF files
EPS files 286
ePublisher Pro 429, 553
equations
delimiters 521
display 522

evaluating 532
formatting 529–532
modifying 527–529
resizing 531
selecting 524
spacing 528
error log, book 349
evaluating equations 532
Exit Application command 517
exit command 517
expressions, conditional text. See Show as per
Expression
expressions, mathematical. See equations
ExtendScript 485
ExtendScript Toolkit 489
Extensible Metadata Platform. See XMP
Extensible Stylesheet Language transform files. See XSLT files

facets, image 288
Favorite View 487
feathering text 261
figures, list of 397
file
 extensions 22
 information, saving 27
 locking 23
 permissions 351
 filename variables 206
<$filename> 191, 206, 558
files
 See also book files; documents; managed documents
generated 341, 507
grouping. See book files
modifying 362
naming conventions for 29
organizing 26, 283
PDF. See PDF files
printing 362
read-only 513
Index

renaming 195, 347
view-only 351, 505, 508–509
fill patterns 312
filters
conversion 70
graphic 278
Find/Change 38, 362
limiting search 40
search options 39
troubleshooting problems 579
Finite Matters Ltd. PatternStream 82, 555
flagging changes. See change bars
Flare 429
flipping graphic objects 334
floating anchored frames 271
flow
definitions, TOC 371
end of symbols 18, 254
tags 219, 245, 266
text. See text flows
fonts
changing defaults 564
default 119
in equations 529
finding renegade 403
list of 401
missing 24, 350
printing accurately 419
substituting 24, 419
units 19
footers. See running headers/footers
footing rows 156, 165
footnotes 64–69
endnotes 64
finding 41
inserting 65
modifying formatting 67
numbering 64–65, 68–69, 360
table footnotes 64, 67–68
forced returns 18
forcing hyphenation 51
foreground pages. See body pages
format catalogs
character 143
color 443
object styles 295
paragraph 131
table 158
formats. See character tags; cross-references;
paragraph tags
formatting
characters. See character tags
cross-references 188
documents 77
equations 529–532
glossaries 142
indexes 387–388
overrides 114
paragraphs. See paragraph tags
tables of contents 369, 373
Formatting Bar 113
formulas. See equations
FrameImage facets 288
FrameMaker
mailing lists 551
preferences 22
scripts 553
starting 9
strengths 3
switching between structured and
unstructured 9
toolbar buttons 20
web sites for 551
FrameReader 505
frames
anchored. See anchored frames
documentgraphic. See graphic frames
text. See text frames
FrameScript 553
FrameVector files 288
FrameViewer 505
freehand curves, drawing 311
FSA IXgen 384
<$fullfilename> 191, 206, 558
functions (mathematical) 521
index

G

gap
  columns, text 249–250, 259
  graphic objects 331
  measurement 14
  tables 162
general macros 441
generated
  files 341, 507
  lists 396
GIF files 286
global
  search-and-replace 582
  updates 149, 163
glossaries, formatting 142
Go to URL command 516
graphic filters 278
graphic frames
  for cropping and masking 326
  drawing 311
  on master pages 219
  on reference pages 290
  renaming 293
graphic objects
  arranging 327–332
  control points 322
  creating 310
  cropping 326
  deleting 315
  distributing 329
  flipping 334
  gap settings 331
  gravity 320, 324
  grouping 330
  layering 332
  orientation 333–335
  resizing 319–321
  rotating 333
  running text around 331
graphic packages 76
graphics
  3D objects 305–308
  active areas, creating 509
  alternate text 283
  anchoring 269–285
  automatically updating from web 275
  bitmap images 277, 287
  choosing best 285
  conditional text, applying 465
  converting for HTML 435
  CorelDraw 286
  cross-platform 288
  end of story 142
  Flash files 299
  formats 285–289
  gray boxes 281, 288, 413
  HTTP file path 276
  image facets 288
  imported, list of 401
  importing 273–274
  on master pages 294
  missing 281
  organizing files 283
  on reference pages 290–293
  resizing imported 279
  scaling 277
  sizing 275
  Snagit 555
  watermark effect 227
  in workflow 76
Graphics Interchange Format files. See GIF files
  gravity 320, 324
  gray boxes for graphics 281, 288, 413
  grids 17, 313
  grouping graphic objects 330
  GroupTitlesIX 389, 391

H

handles
  selection 315, 320–321
  table 157
hanging indent 125

hard spaces 18
headers/footers. See running headers/footers
heading rows 156, 165
headings, numbered 141
Index

heads, run-in 122
heads, side 122, 255
hidden text. See conditional text
hiding conditional text 471
HLS color model 445
hot spots, creating 509
<$hour> 558
<$hour> variables 204
HTML
See also CSS files
color in 457
creating 84
cross-reference mappings 434, 438
graphics formats 435
macros for conversion 441
mapping tables 436
page opening and closing 440
paragraph mappings 431, 437
saving as 430
special character processing 441

HTML Help 83
HTML, saving as 431–435
hyperbolic functions 521
hyperlinks in PDF files 427
hypertext
See also cross-references
creating links 507–509
in generated files 507
image maps 511
pop-up messages 512
read-only documents 513
versus cross-references 506
web addresses 511
Hypertext Markup Language. See HTML
hyphenation 41, 49–51, 127
hyphens
discretionary 18, 51
nonbreaking 51
suppressing 18, 51

I

IgnoreCharsIX 388–389
illustrations. See graphics
Illustrator 76
image
facets 288
maps 511
ImpGraph 269
imported graphics, list of 401
importing
bitmap images 277
graphics 273–274
list of graphics 401
from Microsoft Word 72
settings from template file 91–92
SVG files 277
text from other applications 70
text. See text insets
user variables only 581
vector graphics 275
inconsistent
color settings 351
conditional text settings 351
indents
basic 116, 118
hanging 125
table 160
indexes
of authors 403
creating 380–381
custom 402–404
editing and deleting entries 384
embedded 77
embedded vs. stand-alone 78
entry basics 380–387
file-level 381
formatting 386–388
inserting entries 382
markers 382
page number formatting 391, 393
page ranges 382, 385, 392
page separators 389
planning 77
reference pages 388
removing chapter numbers 393
"see also" references 387
"see" references 386
sort order 387, 390
stand-alone 77–78, 381
subentries 381, 384
tips 383
workflow 77
IndexIX 389, 391
ini. See maker.ini
inline equations 522
inserting
anchored frames 270
cross-references 185
equations 522
footnotes 65
special characters 35
tables 155–158
variables 200–201, 581
insets, text. See text insets
interface, switching between structured and unstructured 29
interline and interparagraph padding 261
IX flow 388
IXgen 384

J

job options for PDF files 416
joining lines 324
JPEG (Joint Photographic Experts Group) files 286
Jump Back command 515
Jump to commands 514
justification, line 116

K

keep with settings 122
kerning, pair 121
527
keyboard shortcuts
applying conditional text 465
character tags 144
equations 527
inserting variables 201
moving equations 527
paragraph tags 114
problems with 114, 145
special characters 37
unsupported from previous versions 37
knock out 450

L

landscape master pages 228–232
language
dictionary 120
support 86
<$lastpagenum> 205, 559
layering graphic objects 332
layout overrides 241–243
leaders, dot 374
leading. See line spacing
Leximation tools 554
libraries, color 445, 452
lighting 3D objects 307
line ends 312
justification 116
patterns 312
widths 312, 317
line breaks
in equations 528, 531
restricting 54
in TOC 378
line spacing
adjusting 528
negative 142
setting 117
lines
dashed 319
drawing 311
## Index

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>joining</td>
<td>324</td>
</tr>
<tr>
<td>links</td>
<td></td>
</tr>
<tr>
<td>hypertext. See hypertext</td>
<td></td>
</tr>
<tr>
<td>web address</td>
<td>511</td>
</tr>
<tr>
<td>list of</td>
<td></td>
</tr>
<tr>
<td>figures</td>
<td>397</td>
</tr>
<tr>
<td>markers</td>
<td>399</td>
</tr>
<tr>
<td>paragraphs</td>
<td>398</td>
</tr>
<tr>
<td>references</td>
<td>399–402</td>
</tr>
<tr>
<td>tables</td>
<td>398</td>
</tr>
<tr>
<td>literals</td>
<td>383</td>
</tr>
<tr>
<td>locking files</td>
<td>23</td>
</tr>
<tr>
<td>log</td>
<td>349</td>
</tr>
<tr>
<td>logarithmic functions</td>
<td>521</td>
</tr>
<tr>
<td>lowercase text</td>
<td>121</td>
</tr>
<tr>
<td>low-resolution images, printing</td>
<td>413</td>
</tr>
<tr>
<td>master pages</td>
<td></td>
</tr>
<tr>
<td>See also body pages</td>
<td></td>
</tr>
<tr>
<td>applying and assigning</td>
<td>220–221</td>
</tr>
<tr>
<td>bleeding thumb tabs</td>
<td>232–236</td>
</tr>
<tr>
<td>creating</td>
<td>219–224</td>
</tr>
<tr>
<td>creating default pages</td>
<td>221</td>
</tr>
<tr>
<td>custom</td>
<td>221</td>
</tr>
<tr>
<td>deleting</td>
<td>243</td>
</tr>
<tr>
<td>displaying</td>
<td>220</td>
</tr>
<tr>
<td>graphics, importing on</td>
<td>294</td>
</tr>
<tr>
<td>landscape</td>
<td>228–232</td>
</tr>
<tr>
<td>mapping table</td>
<td>238</td>
</tr>
<tr>
<td>mapping tags</td>
<td>238–241</td>
</tr>
<tr>
<td>modifying</td>
<td>224–236</td>
</tr>
<tr>
<td>page layout overrides</td>
<td>241–243</td>
</tr>
<tr>
<td>reapplying globally</td>
<td>237</td>
</tr>
<tr>
<td>rearranging</td>
<td>223</td>
</tr>
<tr>
<td>removing overrides</td>
<td>237–243</td>
</tr>
<tr>
<td>renaming</td>
<td>223</td>
</tr>
<tr>
<td>running headers/footers</td>
<td>224</td>
</tr>
<tr>
<td>text flows</td>
<td>245–253</td>
</tr>
<tr>
<td>variables in</td>
<td>200, 207, 581</td>
</tr>
<tr>
<td>watermarks</td>
<td>225–227</td>
</tr>
<tr>
<td>MasterPageMaps reference page</td>
<td>238–241</td>
</tr>
<tr>
<td>math. See equations</td>
<td></td>
</tr>
<tr>
<td>matrix command</td>
<td>516</td>
</tr>
<tr>
<td>merging table cells</td>
<td>172</td>
</tr>
<tr>
<td>merging table cells. See straddling table cells</td>
<td></td>
</tr>
<tr>
<td>Message Client command</td>
<td>516</td>
</tr>
<tr>
<td>messages, pop-up alerts</td>
<td>512</td>
</tr>
<tr>
<td>metadata</td>
<td>27</td>
</tr>
<tr>
<td>Microsoft Visio</td>
<td>76</td>
</tr>
<tr>
<td>Microsoft Word</td>
<td></td>
</tr>
<tr>
<td>importing content from</td>
<td>72</td>
</tr>
<tr>
<td>tables, converting</td>
<td>182</td>
</tr>
<tr>
<td>MadCap Flare</td>
<td>552</td>
</tr>
<tr>
<td>mailing lists</td>
<td>551</td>
</tr>
<tr>
<td>Maker Interchange Format. See MIF files</td>
<td></td>
</tr>
<tr>
<td>maker.ini</td>
<td></td>
</tr>
<tr>
<td>always download updated graphics from</td>
<td></td>
</tr>
<tr>
<td>web</td>
<td>275, 564</td>
</tr>
<tr>
<td>customizing</td>
<td>563–565</td>
</tr>
<tr>
<td>setting default substitution fonts</td>
<td>564</td>
</tr>
<tr>
<td>setting pasting order</td>
<td>564</td>
</tr>
<tr>
<td>managed documents</td>
<td></td>
</tr>
<tr>
<td>WebDAV overview</td>
<td>546</td>
</tr>
<tr>
<td>manual resizing</td>
<td>320</td>
</tr>
<tr>
<td>mapping</td>
<td></td>
</tr>
<tr>
<td>tables, HTML</td>
<td>436</td>
</tr>
<tr>
<td>tags to master pages</td>
<td>238–241</td>
</tr>
<tr>
<td>mapping table</td>
<td>238</td>
</tr>
<tr>
<td>margins, table cell</td>
<td>129, 160</td>
</tr>
<tr>
<td>marker indicators</td>
<td>18, 383</td>
</tr>
<tr>
<td>Marker Markup Language. See MML</td>
<td></td>
</tr>
<tr>
<td>&lt;$marker1&gt; variables</td>
<td>208, 559</td>
</tr>
<tr>
<td>markers</td>
<td></td>
</tr>
<tr>
<td>Cross-Ref. See cross-references</td>
<td></td>
</tr>
<tr>
<td>finding</td>
<td>40</td>
</tr>
<tr>
<td>index</td>
<td>382</td>
</tr>
<tr>
<td>index of</td>
<td>403</td>
</tr>
<tr>
<td>Leximation MarkerTools plug-in</td>
<td>554</td>
</tr>
<tr>
<td>list of</td>
<td>399</td>
</tr>
<tr>
<td>text in running header/footer</td>
<td>209</td>
</tr>
<tr>
<td>&lt;$markertext&gt;</td>
<td>399</td>
</tr>
<tr>
<td>masking graphic objects</td>
<td>326</td>
</tr>
</tbody>
</table>

596
Index

MicroType, FrameMaker-to-PDF
  TimeSavers 189, 427, 554
MIF files
  creating 577
  editing 573
  MML 576
  opening 578
  opening in older version 579
  organization of 576
  uses 578–583
  viewing 578
MIF wash 577
MIF2GO 429, 553
<$minute> 204, 559
<$minute00> 559
Miramo 82, 555
missing
  fonts 24, 350
  graphics 281
MML 576
Modification Date variable 203
<$modificationtime> 212, 559
modifying
  character tags 145–147
  color definitions 449–451
  condition tags 469–470

N

<n> building blocks 561
named destinations 427
naming
  colors 451
  graphic frames 293
naming conventions
  files 29
    templates 106–108
navigating in equations 526
negative line spacing 142
network file locking 23
<$nextsubdoc> 441, 559
nonbreaking hyphens 51
nonbreaking spaces 18
nonprinting symbols 17
<$nopage> 381, 559
NOT operator 477

note format 136
notification scripts 488
numbering
  See also autonumbering
    chapters 355
    footnotes 64–65, 68–69, 360
    formats for 353
    headings 141
    multfile chapters 357
    paragraphs 359
    steps 136
    table footnotes 361
    volumes 357
Numbering sheet 124
numerical variables 205
<$numerals> 390, 559
Index

O

object
  linking and embedding 289
  properties, anchored frame 283
Object Model Viewer 493
Object pointer 311, 314
object styles 295
<$Objectld> 559
<$ObjectType> 559
offset printing 445
offset, text 54
See also gap; spacing
OLE 289
Omni Systems MIF2GO 553
online documents 457
  See also HTML; PDF files
online help overview 84
Open Document commands 515
opening
  all files in book 346
  documents 15
  file in older version 579
  MIF files 578
  text files 578
openlink command 515
openlinkfitwin command 515
opennew command 516
openpage command 516
operators
  condition 477
  equation 521
optimizing PDF files 425
OR operator 477
organizing
  directories and files 26
  graphic files 283
orientation of graphic objects 333–335
orphan
  lines 122
  rows 162
ovals, drawing 311
overline 120
overprint 312, 450
overrides
  character tag 147
  formatting 114
  identifying 134
  master page 237–243
  page layout 241–243
  removing 114
P

padding, interline and interparagraph 261
page
  layout overrides 241–243
  number formatting, index 391
  numbering. See pagination
  ranges, index 382, 385, 392
  scrolling 19
  separators, index 389
page breaks
  avoiding awkward 99
  removing 91
Page Count variable 205
page sizes
  checking 236
  custom 13
  landscape 228
  in PDF files 414
  specifying 14
<$pagenum>
  in book files 353
  in cross-references 191
  overview 559
  in tables of contents 372
pages. See blank pages; body pages; master pages; reference pages
pagination
  See also numbering
  managing 352–361
  suppressing in index 381
Pagination sheet 121
pair kern 121
PANTONE colors 453
paper size 14, 411
paragraph
catalog 131
mappings for HTML conversion 437
symbols 18

Paragraph Designer 115–129
paragraph tags
  applying 111–114
  copying 129
  creating 129–132
  customizing 140, 142
  deleting 132
  finding 40
  global changes to 131
  modifying 115–129
  renaming 130
  tips for creating 99

paragraphs
  alignment 116
  blank, removing 369
  color; adding 448
  list of 398
  mappings for HTML conversion 431
  numbering 359
  positioning on page 121
  space above/below 117
  table cells 128

parallel development 80

<$paranum>
  in cross-references 190
  overview 559
  in tables of contents 372
  in variables 205

<$paranum[paratag]> 208
<$paranumonly[paratag]> 208, 559
<$paranumonly> 191, 205, 372
<$paratag[paratag]> 208, 559
<$paratag> 191
<$paratext[+,paratag]> 208
<$paratext[paratag]> 208
<$paratext> 190, 372, 560
<$parentdoc> 441, 560

pasting
  order, setting in maker.ini 564
  text 70

PatternStream 82, 555

PDF files
  Acrobat Distiller 416
  Adobe PDF Creation Add-On 416
  bookmarks 420
  color in 457
  creating 419
  hyperlinks in 427
  job options files 416
  MicroType FrameMaker-to-PDF TimeSavers 554
  optimizing 425
  page size 414
  registration marks 424
  for review 76
  Save As option 419

screen readers 424
  setting default printer 415
  settings 98

themed 424
  threading articles in 422
  troubleshooting 428
  used as graphics 286
  zoom, default 423

pen pattern 312

personal dictionary 43, 47
  pipe symbols 38
  placeholder counters 125
  planning
    indexes 77
    projects 74
    single sourcing 78

PNG files 286
  pointer in FrameMaker 314
  polygons, drawing 311
  polylines, drawing 311
  Popup Menu command 516
  pop-up messages, creating 512
  Portable Network Graphics files. See PNG files

positioning
  See also aligning
    anchored frames 270–272
    equations 520
  preferences
    dictionary 120
    general 22
  preventing
    automatic updates 194
    hyphenation 51
    previouslink command 515
    previouslinkfitwin command 515
Index

<$prevsubdoc> 441, 560
printer-resident fonts 415
printers, changing 414
printing
  in black and white 413
  from book files 409
documents 15, 78, 408–415
double-sided documents 411
files 362
fonts 419
individual document file 409
low-resolution images 413
offset 445
paper size for 411
registration marks 414
specifying pages 409
suppressing blank pages 412

throumbs 412
troubleshooting 410
workflow 78
process color 413, 445
production editing 77
project planning 74
properties
  See also preferences
  anchored frame 283
document 52, 92
text frame 247
proportionate resizing 320
publishing
  database 82, 555
  multichannel 78
  single source 78
  workflow 73

Q

Quadralay WebWorks Publisher. See ePublisher
Pro
question marks
  for equation objects 522

as search wildcards 38
quit command 516
quitall command 516
quotation marks 52, 188

R

<$r> building blocks 561
read/write file permissions 351
read-only documents 513
rearranging
  files in book file 346
graphic objects 327–332
master pages 223
rectangles, drawing 311
reference pages
  graphics on 290–293
  IX flow 388
  mapping tables 238, 436
  TOC flow 369
<$referencename> 400
references
  index of 403
  list of 399–402
Registered View 488
registration marks 414, 424
<$refilename> 560
relinking missing graphics 281
removing
  character tags 151
  condition tags 465
  conditions from text 466
  master page overrides 237–243
  overrides 114
renaming
  character tags 148
  colors 454
  files 195, 347
  graphic frames 293
  master pages 223
  paragraph tags 130
render mode 308
replacing (search and replace) 42
resetting counters 126
reshape handles 321
reshaping graphic objects 321
resizing
  See also scaling
columns, table 157, 166–167
equations 531
graphic objects 319–321
graphics 275
imported graphics 279
manually 320
proportionately 320
SVG files 277
text frames 251
zoom settings 16
resolution, image 275, 413
reviewing documents 76
RGB color model 287, 445
RoboHelp 429, 552
Roman numbering 353

S

saturation, color 452
saving
  all files in book 346
  as HTML 430
  automatically 28
documents 15
  file information 27
  files 430
  as PDF 419
  XML 442
Scalable Vector Graphic files. See SVG files
scaling
  See also resizing
columns, table 167
graphics 277
screen readers
  assigning alternate text for graphics 283
  PDF files for 424
Script Library Panel 486
scripting 485
scripts for FrameMaker 553
scrolling, page 19
search and replace 582
  See also Find/Change
  rotating
    graphic objects 333
    pages 228–232
table cells 174
rounded rectangles, drawing 311
rows, table
  adding and deleting 164–166
  sorting by 175
rubi 41
rulers, displaying 17
ruling
column 162
table cell 169–172
run-in heads 122
running headers/footers
  condition tags, displaying 210
dictionary-style 209
  marker text in 209
  setting up 224
  variables 207, 581
search wildcards 38
<$second> 204, 560
secondary entries, index 381, 384
<$sectionnum>
  in book files 354
“see also” references 387
“see” references 386
selecting
columns, table 56, 157
equations 524
graphic objects 314
table cells 157
text frames 250
selection handles 315, 320–321
separations, color 415
Separators IX 388–389
serial development 80
setting
  anchored frame object properties 283
tab stops 118
shading
columns 163
table cell 163, 169–172
shortcuts
  keyboard. See keyboard shortcuts
<$shortdayname> 204, 560
<$shortmonthname> 204, 560
<$shortyear> 204, 560
Show as per Condition
  showing/hiding 475
tags needed 473
Show as per Expression
  building expressions 476
  layered tags 479
  showing/hiding 476
  single tags 482
tags needed 474
showing and hiding conditional text 471
shrink-wrapping anchored frames 280
side heads 122, 255
Silicon Prairie Software tools 554
single sourcing
  planning 78
  structured versus unstructured 85
  workflow 83
<$singlepage> 560
single-purpose templates 110
single-sided documents 267
site dictionary 44
sizing
  See also resizing
small caps 54, 121
Smart Quotes 52
Smart Select pointer 311, 314
Smart Spaces 53
smoothing graphics 322
SnagIt graphics tool 555
snap grid 252, 313
solid lines 312
sort order; index 387, 390
sorting table data 175
SortOrderIX 388, 390
spaces, nonbreaking 18
spacing
  above and below paragraph 117
  between columns 14
  equations 528
  line 117
  preventing extra 53
  Smart Spaces 53
special characters
  ANSI codes 38
  finding rubi 41
  in HTML conversion 441
  in dialog boxes 102
  inserting 35
  keyboard sequences 37
  pasted from Windows Character Map 37
  symbols toolbar 35
Specify Named Destination command 514
specifying fonts 119
spell-checking 43–51
  book files 362
dictionaries 43
document dictionary, modifying 48
eliminating 142
hyphenation, customizing 49–51
options 45
personal dictionary, modifying 47
splitting text frames 264
spot color 413, 447
spot cross-references 186
spread 120, 528
square brackets
  in building blocks 558
  in indexes 387
  search wildcards 39
squares, drawing 248, 311
stand-alone
  indexes 77–78, 381
  tables of contents 370
Star the dog 279
stars
  See also asterisks
  character overrides 146
<$startrange> 382, 385, 560
steps 136
story. See text flows
straddling table cells 172
straight quotes. See apostrophes; quotation marks
streams, autonumbering 109
stretch, text 55, 120
strikethrough 120
structured authoring 84
structured documents
  versus unstructured 85
XML import, export 84
structured to unstructured interfaces 29
style sheets. See character tags; paragraph tags
subentries, index 381, 384
subscripts 54, 120
<$subsectionnum>
in book files 354
substituting fonts 24, 419
summary reports 61
superscripts 54, 120
suppress hyphens 18, 51
SVG files
output 286

<table>
<thead>
<tr>
<th>T</th>
</tr>
</thead>
<tbody>
<tr>
<td>table anchors 156</td>
</tr>
<tr>
<td>table catalog 158</td>
</tr>
<tr>
<td>Table Cell sheet 128</td>
</tr>
</tbody>
</table>
| table cells
  | aligning 129 |
  | margins 129, 160 |
  | paragraph properties 128 |
  | paragraph tags in 168 |
  | rotating 174 |
  | ruling and shading 169–172 |
  | selecting 157 |
  | straddling 172 |
| Table Continuation variable 206 |
| Table Designer 158, 160 |
| table footnotes, numbering 361 |
| Table Sheet variable 206 |
| table tags
  | changing 158 |
  | creating 164 |
  | deleting 177 |
  | finding 41 |
  | globally updating 163 |
  | modifying 159–164 |
  | overview 155 |
| table variables 206 |
| TableCleaner 72, 182 |
| tables
  | aligning 161 |
  | autonumbering 161 |
  | color in borders 448 |
  | columns. See columns, table |
  | conditional text in 465 |
| tables of contents
  | autonumbering 376 |
  | customizing 368 |
  | embedding in a file 367 |
  | file 368 |
  | formatting 369, 373 |
  | line breaks 378 |
  | setting up 365–369 |
  | stand-alone 370 |
| tabs 18, 118 |
| tag creep 89 |
| Tagged Image File Format files. See TIFF files |
| tagged PDF files 424 |
| tags. See character tags |
| Tasha the dog 278 |
| <$tblsheetcount> 206, 560 |
Index

technical editing 76
TechSmith SnagIt 555
templates
applying 91–92
creating 93–98
default 11
documenting 109
documents used as 12
installed with FrameMaker 90
naming conventions for 106–108
single-purpose 110
structured versus unstructured 85
tips for designing 99–102
writers using 75
text
actual text assignment 284
alternate for graphics 283
appearance 119
block. See text frames
clickable 509
color, adding 120, 448
conditional. See conditional text
conditions, removing 466
configuring default options 52–55
conventions xxxii
copying 70
feathering 261
finding in marker 40
FrameMaker format. See MIF files 573
importing. See text insets
lines, drawing 311
offset. See gap; spacing
pasting 70
repositioning 528
running around a graphic 331
spacing 54
strange characters in 24
stretch 55, 120
symbols 17
tracking edits 56
watermark effect 226
width 55
text flows
adding to master pages 248
columns 259
connecting 253
customizing 253–267
side heads 255
understanding 245–253
text frame overflow 246
text frames
on body pages 249
copying 252
deleting 252
disconnecting 265
drawing 311
flow tags 266
moving 252
multicolumn 249
overview 219, 245
properties 247
resizing 251
selecting 250
splitting 264
text insets
alternatives to 537
converting to text 544
creating 540–542
finding 41
formatting 539
list of 402
managing 542–544
overview 533
planning 538–540
text behavior 536
Thesaurus 50
threading articles in PDF files 422
thumb tabs 232–236
thumbnails, printing 412
TIFF files 286
time variables 203
TimeSavers tool 554
tint 312
TOC flow 371
TOC reference page 369
Tombo registration marks 414
toolbar buttons
inserting symbols 35
overview 20
Tools palette 310–312
track text edits. See tracking changes
tracking changes 55–63
tracking. See spread
trigonometric functions 521
troubleshooting
  book updates 349–351
  color catalog bloated 579
  crash recovery file 28
  errors during printing 409
  file corruption 579
  Find/Change problems 579
  finding unresolved cross-references 41
  graphics too large 289
  gray boxes for graphics 288
  missing fonts 24
  missing graphics 281
  PDF files 428
  printing 410
  reporting bugs 555
  RGB color definitions 287
  side head area not appearing 258
typing
  equations 524
  special characters 35

U,V

underline 120
Unicode support xxvii, 15, 86, 103
units, font and display 19
unresolved
  cross-references 195–197, 351, 402
  text insets 402
unstructured authoring 84
unstructured documents versus structured 85
unstructured to structured interfaces 29
updating
  books 348–351
  catalog settings 581
  cross-references 193–195
  globally 149, 163
  system variables 211
  user variables only 581
uppercase text 121
user variables
  converting to text 214
  creating 212
  deleting 215
  importing without system variables 581
  modifying 214
  overview 199
Finding 41
importing from MIF 581
inserting 200–201, 581
keyboard shortcuts for 201
master page 200, 581
numerical 205
overview 199
running header/footer 207
system definitions, modifying 201–211
table 206
time 203
updating 211
user, creating 212
vector graphics 275, 287
vertical baseline shift 580
viewing
  colors 455–456
  grid lines 314
  MIF files 578
view-only files 351, 505, 508–509
Visio 76
<$volnum>
  in book files 354, 357
  in cross-references 191
  overview 560
  in paragraph tags 139
  in tables of contents 372
  in variables 205
Volume Number variable 205
volume numbers
  building block for 139
displaying 125
volumes, numbering 357
<table>
<thead>
<tr>
<th>W</th>
<th>workflow</th>
</tr>
</thead>
<tbody>
<tr>
<td>warning format</td>
<td>database publishing</td>
</tr>
<tr>
<td>washing MIF</td>
<td>editing</td>
</tr>
<tr>
<td>watermarks</td>
<td>evaluating options</td>
</tr>
<tr>
<td>web address links</td>
<td>FrameMaker-based</td>
</tr>
<tr>
<td>web sites, FrameMaker-related</td>
<td>illustrations</td>
</tr>
<tr>
<td>Web-based Distributed Authoring and Versioning.</td>
<td>indexing</td>
</tr>
<tr>
<td>See WebDAV</td>
<td>modular development</td>
</tr>
<tr>
<td>WebDAV</td>
<td>overview</td>
</tr>
<tr>
<td>24, 546</td>
<td>parallel development</td>
</tr>
<tr>
<td>See also managed documents; workgroups</td>
<td>planning</td>
</tr>
<tr>
<td>WebDAV server</td>
<td>printing</td>
</tr>
<tr>
<td>546</td>
<td>production editing</td>
</tr>
<tr>
<td>widow lines</td>
<td>serial development</td>
</tr>
<tr>
<td>122</td>
<td>single sourcing</td>
</tr>
<tr>
<td>width</td>
<td>78, 83</td>
</tr>
<tr>
<td>table column</td>
<td>writing</td>
</tr>
<tr>
<td>167</td>
<td>75</td>
</tr>
<tr>
<td>text</td>
<td>X,Y,Z</td>
</tr>
<tr>
<td>55</td>
<td>XML</td>
</tr>
<tr>
<td>wildcard</td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>84</td>
</tr>
<tr>
<td>Windows Character Map, pasting from</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>442</td>
</tr>
<tr>
<td>Windows Metafile files. See WMF files</td>
<td></td>
</tr>
<tr>
<td>WMF files</td>
<td>86</td>
</tr>
<tr>
<td>word</td>
<td>XMP</td>
</tr>
<tr>
<td>count</td>
<td>27</td>
</tr>
<tr>
<td>58</td>
<td>xrefs. See cross-references</td>
</tr>
<tr>
<td>spacing</td>
<td>XSLT files</td>
</tr>
<tr>
<td>127</td>
<td>84</td>
</tr>
<tr>
<td>Writing workflow</td>
<td>Wrapping anchored frames to content</td>
</tr>
<tr>
<td>Word. See Microsoft Word</td>
<td>280</td>
</tr>
<tr>
<td></td>
<td>writers, role in workflow</td>
</tr>
<tr>
<td></td>
<td>75</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>X,Y,Z</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>XML</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>XMP</td>
<td></td>
</tr>
<tr>
<td>xrefs. See cross-references</td>
<td></td>
</tr>
<tr>
<td>XSLT files</td>
<td></td>
</tr>
<tr>
<td>84</td>
<td></td>
</tr>
<tr>
<td>&lt;$year&gt;</td>
<td></td>
</tr>
<tr>
<td>204, 560</td>
<td></td>
</tr>
<tr>
<td>yen character</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
</tr>
<tr>
<td>zoom</td>
<td></td>
</tr>
<tr>
<td>16, 423</td>
<td></td>
</tr>
</tbody>
</table>